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Благодарим за приобретение режущего плоттера GCC Expert II. 
Перед началом работы с плоттером необходимо ознакомиться 
с мерами предосторожности и указаниями ниже. 

 

 
    ВНИМАНИЕ 

 
МЕРЫ ПРЕДОСТОРОЖНОСТИ! 

 В целях безопасности при перемещении необходимо надежно удерживать 

режущий плоттер за основание. Запрещается перемещать плоттер, удерживая 

его за боковые поверхности. 
 
 

  
 

O (ВЕРНО) X (НЕВЕРНО) 
 
 Запрещается трясти и бросать держатель ножа — риск отламывания кромки ножа. 

 Запрещается касаться в процессе работы движущихся частей плоттера, включая 

каретку. Следить, чтобы в плоттер не попали волосы и одежда. 

 Кабель электропитания подключать только к розетке с заземлением. 

 Использовать только комплектный кабель электропитания. Следить, чтобы кабель 

электропитания не перекручивался и не застревал между предметами. 

 Запрещается подключать кабель электропитания к сетевому разветвителю, если 

к нему подключено другое оборудование, и использовать удлинительный 

кабель. Это может привести к перегреву и выходу устройства из строя. 

 Инструменты необходимо держать в недоступном для детей месте. 

 Прижимные ролики необходимо выравнивать по белым отметкам. 
 
 

 

Важная информация 

! 

Важная информация 
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1.1 Общая информация 
Режущие плоттеры серии Expert II предназначены для получения созданных 
на компьютере изображений и контурной резки рулонного и листового материала 
на основе поливинила. Режущие плоттеры серии Expert II можно использовать 
не только для качественной резки листовых и рулонных материалов, но и в качестве 
графопостроителей. В настоящем руководстве по эксплуатации рассмотрены 
следующие модели режущих плоттеров серии Expert II: 

 

.Ex II-24 для материалов шириной: от 50 до 719 мм 

.Ex II-24LX для материалов шириной: от 50 до 719 мм, с функцией AAS 

.Ex II-52 для материалов шириной: от 50 до 1470 мм 

.Ex II-52LX для материалов шириной: от 50 до 1470 мм, с функцией AAS 
 
 

1.2 Упаковка 
В комплект поставки моделей серии Expert II входят перечисленные 
ниже компоненты. Следует внимательно проверить комплектацию,  
и в случае нехватки компонентов обратиться к региональному дилеру. 

 
 
 

 

Раздел 1. Общие сведения 
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1.3 Технические характеристики 
Ниже перечислены основные технические характеристики режущих плоттеров 
серии Expert II: 
• двухпортовое подключение: последовательный интерфейс и USB; 
• усилие реза до 350 гc; 
• скорость реза до 705 мм (EXII-24(LX) и 635 мм (EXII-52 (LX)) в секунду 

(под углом 45 градусов); 
• гарантированное отслеживание точности в 3 метра; 
• улучшенная система автоматического выравнивания (AAS II)  

для автоматической контурной резки (только для моделей LX). 

 
1.4 Внешний вид (EX II) 
1.4.1 Вид спереди 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A 
E F G 

B C D 

H 

Рис. 1-1 

Объект Описание 
A Основной прижимной ролик Удерживает материал при резке 
B Отрезной паз Помогает ровно отрезать материал 
C Линейка Выравнивание по прозрачным меткам 
D Каретка инструментов Резка устанавливаемым ножом или построение 

пером 

E Держатель ножа Фиксирует нож 
F Опорная пластина Фиксирует и поддерживает материал при резке 
G Марзан Защищает нож и пластину при работе 
H Панель управления 10 клавиш и 6 светодиодных индикаторов 
J Решетчатый барабан Перемещает материал вперед и назад 
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1.4.2 Вид сбоку 
 

 
N O 

 
Рис. 1-3 Рис. 1-4 

 
 

Объект Описание 
K Соединитель питания 

переменного напряжения 
Для подключения шнура питания 

L Предохранитель 3 А 
M Силовой выключатель Включение и отключение устройства 
N Порт USB Подключение режущего плоттера к компьютеру 

через кабель USB 

O Порт последовательного 
интерфейса 

Подключения режущего плоттера к компьютеру 
через кабель RS-232 

 
 
 
 

 

Рис. 1-2 

J 

K L M 
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2.1.    Меры предосторожности 

Перед началом установки изучить информацию ниже. 
 

Примечание 1 
 

 Перед установкой режущего плоттера убедиться, что силовой выключатель 
находится в отключенном положении. 

 
 Во избежание травм соблюдать осторожность при перемещении плоттера. 

 

Примечание 2 Порядок выбора места установки режущего плоттера 
 

До начала установки режущего плоттера выбрать подходящее место, отвечающее 
следующим условиям. 

 
 Имеются удобные подходы к устройству со всех сторон. 

 
 Имеется достаточно места для плоттера, вспомогательного оборудования 

и расходных материалов. 
 

 Поверхность установки устойчива, не допускает значительной вибрации. 

 Температура в помещении от 15 до 30 °C. 

 Относительная влажность в помещении от 25 % до 75 %. 
 

 Устройство защищено от пыли и сквозняков. 
 

 На устройство не попадает яркий и прямой солнечный свет. 
 

Примечание 3 Порядок подключения шнура электропитания 
 

Убедиться, что вилка шнура электропитания подходит к настенной розетке. Если нет, 
связаться с дилером. 

 
 Вставить вилку в розетку электропитания с заземлением. 

 
 Второй конец шнура подключить к соединителю питания режущего плоттера. 

 

Примечание 4 Порядок затяжки и ослабления винтов 
 

При работе ключом и электрической отверткой необходимо соблюдать 
осторожность и не прилагать чрезмерных усилий при затягивании и ослаблении 
винтов. При затягивании и ослаблении винтов из обычной и нержавеющей стали 
пользоваться следующей таблицей расчета усилия затяжки винта. Расчеты для 
винтов из других материалов не приведены. 

Раздел 2. Установка 
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Диаметр 

винта 
Усилие затяжки (кгс/см) 

Стандарт затяжки для высокопрочных материалов 
M3 6 
M4 16 
M5 30 
M6 50 
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2.2 Установка стойки 
Для моделей на 24 дюйма (61 см) стойка приобретается дополнительно. 

 

2.2.1 Установка стойки 
Для сбора стойки следовать инструкциям ниже. 

 
 
Шаг 1 Перед началом установки найти в картонной коробке со вспомогательными 
компонентами к стойке такие детали: 
Для Expert II стойка приобретается дополнительно, список деталей: 

 Левая сторона вертикальной стойки — 1 шт. 
 Правая сторона вертикальной стойки — 1 шт. 
 Опора для левой стороны — 1 шт. 
 Опора для правой стороны — 1 шт. 
 Траверса — 1 шт. 
 Нижние стойки с колесами — 2 шт. 
 Скользящие опоры для захвата бумаги — 2 шт. 
 Ключ под внутренний шестигранник (М5) диам. 4 — 1 шт. 
 Винты с потайной головкой (M6х12) — 28 шт. 
 Руководство по монтажу — 1 шт. 

 
 
 
Шаг 2 
Расположив левую вертикальную стойку перпендикулярно к элементу , вставить 
в отверстия винты и затянуть их, получив левую T-образную стойку (рис. 2-1). 
Повторить для правой вертикальной стойки. 

 
 
 
 
 

Левая вертикальная 
стойка 

 
 
 
 
 
 

Нижняя стойка 
 

Рис. 2-1 
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Шаг 3 
Поместив траверсу прямо на T-образную стойку, вставить в отверстия винты, 
но пока не затягивать. Центровочные штифты не предусмотрены. Совмещать 
винты с головкой с внутренним шестигранником с резьбовыми отверстиями 
на обеих T-образных стойках. 

 
 
 

Траверса 
 
 
 
 
 
 
 

 T-образная стойка 
 
 
 
 

Рис. 2-2 
 
 
 
Шаг 4 
Извлечь режущий плоттер из коробки. Установить стойку под плоттером. На нижней 
части плоттера с каждой стороны имеется по одному отверстию для центровочных 
штифтов. Вставить штифты в отверстия. После этого вставить винты в отверстия 
на стойке, чтобы закрепить плоттер, и затянуть их, как показано на рис. 2-3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Винты 
 
 

Рис. 2-3 
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Шаг 5 
Совместить отверстия на опорах держателя рулона с резьбовыми отверстиями 
стойки, наживить и затянуть винты, как показано на рис. 2-4. Резьбовые отверстия 
выбираются в зависимости от желаемого положения опоры. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Опора держателя рулона 
 
 

3 винта 
 
 
 
 

Шаг 6 
Поместить два держателя рулона на опору и убедиться, что белая выступающая 
часть лежит в прорези (рис. 2-5). 

 

  

 

Рис. 2-4 
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Шаг 77 
Сняв упаковку с держателя рулона 2, повернуть винт против часовой стрелки около 
трех раз (рис. 2.2-9). 

 

 
 

Шаг 8 
Вставить торец держателя рулона без демпфера в левую опору держателя. Затем 
вставить торец держателя с демпфером в правую опору. Убедиться, что белая 
выступающая часть лежит в прорези. 
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Шаг 9 
Затянуть винт на демпфере так, чтобы плотно притянуть держатель к правой опоре. 

 

 
 
 
Шаг 10 
После сборки устройство должно выглядеть, как показано ниже (рис. 2-6). 

 

 

Рис. 2-6 
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2.3 Хомут и кронштейн для кабеля USB 

 
Хомут и кронштейн для кабеля USB устанавливаются только в комплекте с подставкой 
для гибких материалов. 

 
 
Шаг 1 Хомут для кабеля продеть сверху вниз через верхнее отверстие кронштейна. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Этой стороной вверх 
 
 
Шаг 2 Поместить кабель USB в хомут и затянуть хомут. 

 

  
 

Шаг 3 Вставить конец хомута с кабелем в нижнее отверстие кронштейна. 
 

  
Как освободить кабель: вытянуть хомут   поднять защелку   ослабить хомут. 
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Вытянуть хомут 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Поднять защелку 

 Ослабить хомут 
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2.4 Установка ножа 

 

 
На рис. 2-7 показан держатель ножа. 
Нож вставляется в нижнюю часть 
держателя. Для извлечения 
необходимо нажать на штифт. 
Запрещается касаться острия ножа 
пальцами. 

 

Штифт 
 
 
 
 

Внешнее кольцо  

Винт регулировки высоты 

  

Рис. 2-7 
 
 
 
Шаг 1  Шаг 2 
Вставить нож (рис. 2-8).  Протолкнуть нож в нижнюю часть 

держателя (рис. 2-9). 
 

  

Рис. 2-8 Рис. 2-9 
 
 
 
Шаг 3 
Отрегулировать вылет режущей части, 
поворачивая винт регулировки ножа 
по часовой или против часовой стрелки 
(рис. 2-10). 

 

 

Рис. 2-10 

Совет: 
Оптимальной высотой режущей 
части считается лезвие, вылет 
которого на 0,1 мм больше толщины 
пленки. Если толщина пленки 
составляет 0,5 мм, вылет ножа 
необходимо установить на 0,6 мм, 
чтобы нож полностью прорезал 
пленку, но не подложку. 
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Осторожн
 

 
Шаг 4 
Вставить держатель ножа в каретку. Убедившись, что внешнее кольцо держателя 
надежно входит в желоб каретки (рис. 2-11), закрепить крышку (рис. 2-12). 

   

Рис. 2-11 Рис. 2-12 
 
 
Шаг 5 
Для демонтажа держателя повторить шаги в обратном порядке. 

 
 
 
Шаг 6 
Извлечение ножа. Чтобы извлечь нож, подлежащий замене, нажать на «Штифт для 
извлечения ножа». 

 
 

 

  
 Внимание! 

Спустя определенное время эксплуатации нож утрачивает остроту; это 
может повлиять на качество реза. Компенсировать этот эффект можно 
увеличением усилия реза. Но если нож изношен и режет нестабильно, 
его следует заменить новым. Нож — это расходный материал. Чтобы 
обеспечивать качество реза, его необходимо заменять так часто, как 
потребуется. Качество ножа существенно влияет на качество реза. Для 
достижения хороших результатов следует использовать ножи высокого 
качества. 

 
Советы Когда заменять нож на новый: 
 Если нож сломался, его следует заменить новым. 
 Если качество резки упало, возможно, нож следует заменить 

новым. 
 Если материал не режется даже при увеличении усилия реза, 

возможно, нож следует заменить новым. 
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2.5 Загрузка материала 

 
2.5.1 Загрузка листового материала 
Для правильной загрузки материала 
выполнить перечисленные ниже шаги: 

 
Шаг 1 
Поднять два прижимных валика двумя рычагами 
с тыльной стороны плоттера (рис. 2-13). 

 
 
 
Шаг 2 
Наложить материал на опорную пластину 
и протолкнуть его под прижимные ролики 
спереди или сбоку. Для выравнивания 
материала на опорной пластине имеются 
приводочные линейки (рис. 2-14). 

 
 

 

Рис. 2-14 
 
Шаг 3 
Вручную переместить прижимные ролики в нужное положение. Прижимные ролики 
должны находиться на решетчатом барабане. Положение решетчатых барабанов 
показано наклейками на основной траверсе (рис. 2-15). 

 

 

Рис. 2-16 Рис. 2-15 
Наклейки 

Рис. 2-13 
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Шаг 4 
Отвести рычаг назад, чтобы опустить прижимные ролики (рис. 2-16). 

 
 
Шаг 5 
Включить питание. Каретка инструмента автоматически определит размер материала. 
Режущий плоттер начнет работать.  

 Проверить правильность положения вспомогательного 

и  основных прижимных роликов. 

 Установить основные прижимные ролики справа и слева 

от материала. 

 Установить вспомогательный прижимной ролик по центру 

материала.  

Примечание. На иллюстрации плоттер Expert II 
 

(О) 
ВЕРНО 

 

(Х) 
НЕВЕРНО 

 

Вспомогательный  
прижимной ролик 

 

Основной 
прижимной ролик 
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Рис. 2-19 Рис. 2-20 

(O) (X) 

 Верно Неверно 
 
2.5.2 Загрузка рулонного материала 

 

Возможно использование стойки. Настройка аппаратной части — см. главу 2.2.  
Загрузка материала — см. главу 2.5.1. 

 
 

2.5.3 Как повторно замерить рабочую область, не отключая устройство? 
 

При работающем устройстве нажать Origin set. Когда начнет мигать красный сигнал 
ошибки, нажать еще раз. Устройство начнет работать для повторого замера рабочей 
области. Открыть программу VLCD. В разделе Poll size будут указаны новые размеры. 

 
 
 
 
 
 
 
 
 

Примечание 
 Регулировку положения проводить только с поднятыми прижимными 

роликами. 
 Чтобы изменить положение прижимного ролика, его удерживают 

за центр и перемещают по направлению от задней части (рис. 2-19). 
 НЕ ПЕРЕМЕЩАТЬ прижимной ролик за переднюю прорезиненную часть 

(рис. 2-20). 
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Осторожн
 

 

2.5 Кабельные соединения 
 
Режущий плоттер обменивается данными с компьютером через порт USB (Universal 
Serial Bus) или последовательный порт (RS-232C). В этом разделе рассмотрено 
подключение плоттера к основному компьютеру, а также настройка обмена данными 
компьютера с плоттером. 

 
 

ПРИМЕЧАНИЕ. При установке соединения через USB последовательный порт 
отключается автоматически. 

 

 
2.5.1 Интерфейс USB 
USB-интерфейс плоттеров серии Expert II соответствует спецификации универсальной 
последовательной шины версии 2.0 (полная скорость). 

 
2.5.1.1 Подключение режущего плоттера GCC 

1. Включить компьютер. 
2. Подключить к устройству кабель USB. Драйвер USB будет установлен 

автоматически. Обнаружение устройства занимает до нескольких минут. 
НЕ ДОПУСКАЕТСЯ отсоединять кабель USB до завершения процесса 
установки. 

3.  Дважды щелкнуть на значке USB на панели задач, убедившись, что 
компьютер распознал устройство. 

 
 
 
 
 

2.5.1.2 Установка драйвера 
Для быстрой установки драйвера рекомендуется использовать мгновенную 
установку. Для настройки выполнить перечисленные ниже шаги. 

 

 
 

Шаг 1 Вставить установочный диск DVD в устройство чтения компакт-дисков. 
Перед началом установки драйвера убедиться, что USB-устройство 
подключено. 

Шаг 2 Выбрать из списка драйверов нужную модель и нажать Windows Driver (Win 7 
and Above) (Automatic Detection) или Windows Driver (Win 7 and Above) 
(Manual Selection), чтобы установить драйвер и модуль AAS. 

 Если на компьютере установлена ОС Windows 7 и выше, 
в систему входить через учетную запись с правами 
администратора. 
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Шаг 3 Запустить установку драйвера, нажав Next. 
 

 
 

Шаг 4 Для установки драйвера пользователям Windows 7 и выше необходимо 
нажать на красную ссылку и прочесть, как отключить функцию обновлений 
Windows Update. Нажав OK, перейти к следующему шагу. 

 

 
 
 

Шаг 5 Убедившись, что питание включено и плоттер подсоединен к разъему 
USB, нажать кнопку OK. 

  
 

Шаг 6 Перед началом установки подтвердить закрытие работающих 
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программ и нажать OK. 

 

 
 

Шаг 7 Установка занимает несколько минут. По окончании установки на экране 
появится следующее сообщение, под которым нужно нажать ОК. 
Надеемся, вам понравится работать с плоттером GCC! 

 

 
 
 

Шаг 8 Чтобы установить AASII VBA в ПО CorelDRAW и Adobe Illustrator, закрыть 
CorelDRAW и Adobe Illustrator и нажать кнопку Install. 

 

 
 
 

Шаг 9 Проверить версии CorelDRAW и AI в окне Install Message, затем щелкнуть 
на кнопке OK. 
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Примечание: 

(1) При повторной установке пользователю необходимо подтвердить, нужна 
ли ему копия уже установленного драйвера. 

 

 

(2) При выборе опции Yes будет установлена еще одна копия драйвера. 
 

 
(3) Пользователям, обновившим Adobe Illustrator или CorelDRAW, нужно открыть 

вкладку AAS Installer в окне Свойства принтера и нажать Install 
(Установить), чтобы получить доступ к последней версии модуля GCC AAS. 
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2.5.1.3 Удаление драйвера 
 

Перед установкой новой версии драйвера с компьютера необходимо полностью 
удалить предыдущую версию. Процедура удаления описана ниже. 

 
 
 

Шаг 1 Выполнив Control Panel > Hardware (Панель управления > Оборудование и 
звук), открыть окно Sound/Devices and Printers (Просмотр устройств и 
принтеров). Щелкнув правой кнопкой мыши на принтере, выбрать Remove 
device (Удалить устройство). 
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Шаг 2 После удаления устройства щелкнуть на любом принтере в окне и выбрать 

Print server properties (Свойства сервера печати) — для Windows 7 и выше. 
Для Windows XP: щелкнуть правой кнопкой не на принтере, а на пустом месте 
в окне, и выбрать Print server properties. 

 

 
 
 
 
 

Шаг 3 Перейти на вкладку Drivers. 
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Шаг 4 Выбрав нужную модель, нажать Remove (Удалить). 

 

 
 
 

Шаг 5 Выбрав Remove driver and driver package (Удалить драйвер и пакет драйвера), 
нажать кнопку OK. 

 

 
 
 

Шаг 6 Выбрать Yes, нажать кнопки Delete и OK. Установленный драйвер будет 
удален с компьютера. 
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2.5.2 Интерфейс RS-232 
 Подключение к порту RS-232 (последовательному) 

 
1. Для пользователей IBM PC, PS/2 и совместимых устройств: подключить 

кабель RS-232C к нужному последовательному порту (COM1 или COM2) 
главного компьютера. 

 
2. Настроить параметры обмена данными (Baud Rate (Скорость бит/с) и Data 

Bits/Parity (Кол. бит /четность)) в соответствии с параметрами ПО. См. раздел 
3 — описание клавиши Misc. 

 
 

 
 
 
2.5.3 Передача данных 
Передать данные с компьютера на режущий плоттер можно двумя способами: 

 

Вариант 1. При правильно настроенных параметрах можно передавать данные 
из программы прямо на режущие плоттеры. 

 
Вариант 2. Практически все программы поддерживают эмуляцию команд HP-GL 

и HP-GL/2. Если файл в формате HP-GL или HP-GL/2, ошибки при выводе 
на режущем плоттере исключены. 

Осторожно! Отключить плоттер перед подсоединением кабеля RS-232C. 
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2.5.4 Настройка общего доступа 
На компьютере A-PC настроить драйвер принтера как общий принтер, затем 
использовать компьютер B-PC для подключения к принтеру A-PC через Intranet. 

 

 
 
 
 
Шаг 1 На компьютере A-PC настроить драйвер принтера как общий принтер. 

(Щелкнуть правой кнопкой мыши на значке принтера, выбрать Printer properties 
(Свойства принтера). Нажать Sharing (Общий доступ), затем Share this printer 
(Общий доступ к принтеру). 

  

Intranet 

USB или COM 

A-PC B-PC 



Expert II. Руководство 

Установка 2-24 

 

 

 

Шаг 2 На вкладке Advanced выбрать Print directly to the printer. 
 
 

 
 
 
 
 
 
 
Шаг 3 Отправить задание с компьютера A-PC на устройство, чтобы проверить, 
подключен ли к устройству компьютер A-PC. 

 

 
 

 

Отправить 
задание, чтобы 
проверить 
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Шаг 4 Активировать драйвер принтера для компьютера A-PC через сеть B-PC. 
 

   
 
 

Шаг 5 Правой кнопкой мыши щелкнуть на значке принтера и выбрать Connect 
(Подключить) для принтера A-PC. 

 

 
 
 
 
2.6 Установка программ 

 
2.6.1 Установка GreatCut 

 

Шаг 1 На установочном диске выбрать опцию GreatCut Registration. 
На веб-сайте http://gccvoucher.eurosystems.lu/ ввести код с купона, 
полученного при покупке GreatCut, и нажать Go on! 

 

 

http://gccvoucher.eurosystems.lu/
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Шаг 2 Кнопкой Request (Запрос) перейти на страницу регистрации. 
 

 
 
 
Шаг 3 Ввести нужную информацию и щелкнуть на кнопке Request license code 
(Запросить код лицензии). 

 

 
 
Шаг 4 Регистрация завершена. По электронной почте будет отправлено два 

сообщения: первое с подтверждением регистрации и ссылкой для активации, 
второе — с данными лицензии в формате .ecf. 
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Шаг 5  Найти ссылку для активации в полученном письме и перейти по ней для загрузки 
Great Cut. 

 

 
 
 

Шаг 6 Выбрать Install GreatCut из меню установочного диска DVD. 
 

 
 

Шаг 7 Указать папку для установки. 
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Шаг 8 Установив переключатель Typical (Стандартная установка), нажать Next. 
Примечание. Для установки дополнительных драйверов выбрать Сustom 
(Пользовательская установка). 

 
 

Шаг 9  Указать нужную папку и щелкнуть на кнопке Next. 
Папка для установки по умолчанию в меню Пуск: GCC/GreatCut 3. 

 

 
 
Шаг 10 Программа GreatCut устанавливается на компьютер. 
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Шаг 11 Завершить установку щелчком на кнопке Finish. 
 

 
 
 

Шаг 12 Не запуская программу GreatCut, открыть файл .ecf, приложенный к письму 
с данными по лицензии. Необходимая информация будет автоматически 
добавлена в GreatCut, и ее не придется вносить повторно. 
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Шаг 133 Если лицензию установить не удалось, поля заполняют вручную. 
Вся нужная информация находится в электронном сообщении. 

 

 
 

 

 
Шаг 14 Программа GreatCut готова к работе. 

 

 
 
 
2.6.2 Установка Sure Cuts A Lot (приобретается дополнительно) 

 

2.6.2.1 Автоматическая установка 
 

Шаг 1 Вставить установочный диск DVD в устройство чтения компакт-дисков. 
Программа совместима с Windows 7 и выше, Macintosh OSX 10.6 и выше. 
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Шаг 2 Для запуска установки выбрать Sure Cuts A Lot. 
 
 
Шаг 3 Для продолжения нажать кнопку Next. 

 

 
 
 
Шаг 4 Установить флажок I accept the agreement (Принимаю соглашение)  

и нажать Next. 
 

  
 
 

Шаг 5 Принять предложенную по умолчанию папку установки или выбрать другую 
папку для установки и нажать Next. 
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Шаг 6 Для создания значка программы на рабочем столе, установить флажок Create 
a desktop icon. Чтобы по умолчанию открывать файлы с расширением scut4 
программой Sure Cuts A Lot, установить флажок Associated scut4 extension. 
Запустить установку, нажав Next. 

 
 

  
 
 
Шаг 7 Не следует устанавливать флажок Install USB Driver (Установить драйвер 

USB). Установить флажок Launch Sure Cuts A Lot (Запустить Sure Cuts A Lot) 
и завершить установку кнопкой Finish. 
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Шаг 8 Запустить программу Sure Cuts A Lot. 
 

 
 

Шаг 9 Для активации программы Sure Cuts A Lot нажать Activate… Предварительно 
следует убедиться в наличии доступа к Интернету. 

 

Шаг 10 Указать имя в графе Name и ввести в поле Serial (Серийный номер) код из 
25 символов, указанный на обложке диска DVD. Завершить активацию 
кнопкой OK. 

 

 
 

 



Expert II. Руководство 

Установка 2-34 

 

 

 

Шаг 11 Программа Sure Cuts A Lot готова к работе. 
 
 

 
 
 

 
 
 
 
 

2.6.2.2 Активация программного обеспечения вручную 
 

Если на компьютере, подключенном к плоттеру, отсутствует доступ к Интернету, для 
завершения активации и работы с программой можно выбрать Activate manually 
и ввести код активации. Для этого следует найти компьютер с доступом к Интернету 
и заранее получить код активации, следуя инструкции ниже. 

Примечание 
 Если для вывода изображений используется пробная версия 

(не введен ключ для активации программы Sure Cuts A Lot, как описано 
выше), плоттер прорежет на материале две лишние линии. До отправки 
файлов на резку необходимо убедиться, что лицензия Sure Cuts A Lot 
активирована. 
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Шаг 11 Установить флажок Activate manually, чтобы вывести на экран поля Site Code 
и Activation Code. В поле Site Code уже есть данные, которые нельзя 
изменить. 

 

 
 
 

Шаг 2 На компьютере с доступом к Интернету открыть веб-страницу 
http://www.craftedge.com/activation/surecutsalot . Ввести имя, серийный номер 
(ключ программного обеспечения с обложки диска DVD) и код сайта (Site 
Code). 

 
Шаг 3 По щелчку на кнопке Generate Activation Code (Генерировать код активации) 

в поле Activation Code появится код активации. 
 

 
 
 
Шаг 4 Код активации необходимо скопировать и вставить в диалоговое окно 

активации Sure Cuts A Lot, затем подтвердить кнопкой ОК. 

http://www.craftedge.com/activation/surecutsalot
http://www.craftedge.com/activation/surecutsalot
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2.6.2.3 Повторная установка Sure Cuts A Lot 
 

В случае замены компьютера может потребоваться деактивация программы  
Sure Cuts A Lot с повторной установкой на новом устройстве. 

 
Для этого выполнить Deactivate… из меню Help и подтвердить действие кнопкой Yes. 
Затем программу устанавливают на новом компьютере и активируют с помощью  
того же кода. 
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3.1 Панель управления 
 

3.1.1 Схема панели управления 

 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 3-1 
 

Элемент Функция 

LED-ИНДИКАТОР 
ПИТАНИЯ POWER 

Оповещение о состоянии (индикатор горит: питание включено; индикатор 
не горит: питание отключено) 

ИНДИКАТОР ОШИБКИ 
ERROR 

Оповещение об ошибке (индикатор горит: ошибка; индикатор не горит: 
норма). 

ON/OFF LINE Переключение режимов и остановки задания (индикатор горит: работа; 
индикатор не горит: ожидание). В режиме работы доступны только кнопки 
ON/OFF LINE и PAUSE. В режиме ожидания можно регулировать настройки 
через ПО VLCD. 

PAUSE Приостановка и возобновление резки. 

REPEAT Повтор последней работы. 

DATA CLEAR Очистка буфера памяти. 

CUT TEST Проверка реза на различных материалах. 

ORIGIN SET Настройка нового положения исходной метки. 

4 клавиши со 
стрелками 

Смена положения каретки, выбор функции и изменение настроек. 

 
3.1.2 Перенастройка исходной точки 

 

 

Примечание. 
 Перед активацией функции убедитесь, что устройство находится 

в режиме ожидания. 

Раздел 3. Эксплуатация 
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Шаг 1 Переместите каретку в новое положение. 

Шаг 2 Нажмите кнопку ORIGIN SET, чтобы задать новую исходную точку. 
3.1.3 Тестовый рез 

 

 
 

Шаг 1 После снятия размеров перевести устройство в режим ожидания кнопкой 
ON/OFF LINE. 

Шаг 2 Передвинуть каретку в нужное положение. 

Шаг 3 Нажать кнопку CUT TEST. 
 

3.1.4 Повтор 

 
 

 
Шаг 1 Перевести устройство в режим ожидания кнопкой ON/OFF LINE. 

 

Шаг 2 Нажать кнопку REPEAT и запустить повторное определение рабочей зоны, 
начиная с местоположения каретки. Допускается переместить каретку 
в нужное положение, задать новую исходную точку и после этого 
активировать данную функцию. 

3.1.5 Повтор задания AAS 
Функция позволяет автоматически повторять задания из AAS без отправки 
с компьютера. 

 
Шаг 1 После завершения первого задания AAS нажать «Repeat» на панели 
управления для активации функции. 

 

Примечание. 
 Внимание: функция обычно применяется для режима бумаги 

Single. Перед нажатием кнопки Repeat убедиться, что загружен 
новый материал и в качестве исходной точки задана первая 
приводочная метка. 

Примечание. 
 Убедитесь, что устройство находится в режиме ожидания. 

Примечание. 
 Убедитесь, что устройство находится в режиме ожидания. 
 Перед началом резки рекомендуем несколько раз выполнить 

тестовый рез, пока не будет получено нужное качество. 
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3.2 VLCD 
VLCD — компьютерная программа для изменения параметров функций реза. 

 

3.2.1 Установка 
Шаг 1 Для установки скопировать файл VLCD.exe из папки Accessories 

на установочном DVD-диске на локальный компьютер. 
 

Шаг 2 Запустить VLCD двойным щелчком на значке программы. 
 

 
 

Шаг 3 Выбрать порт подключения к компьютеру (рис. 3-2). 
При использовании кабеля USB из раскрывающегося меню выбрать название 
модели. При использовании кабеля последовательного интерфейса выбрать 
COM1 или COM2. Убедиться, что к нужному порту не подключены другие 
устройства. 

Шаг 4 Нажать кнопку Connect, запустив обмен данными между компьютером 
и плоттером. В случае успешного подключения на экране появится 
информация о модели, версии встроенного ПО и настраиваемых 
параметрах (рис. 3-3). 

 

  
 

Рис. 3-2 Рис. 3-3 

Примечание. 
 Перед запуском программы убедиться, что устройство находится 

в режиме ожидания. 
 В устройстве находится материал. 
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3.2.2 Функции VLCD 
 

Ниже перечислены функции Expert II для управления через VLCD: 
 Замер рабочей области 
 Усилие реза 
 Держатель ножа 
 Плотность материала 
 Смещение ножа 
 Смещение AAS 
 Автоматическая размотка 
 Обновление 

 
 
 
 
 

Для замера и отображения 
значений X/Y. 

 

В данном случае максимальная 
длина реза составляет 25 000 мм, 
расстояние между двумя наиболее 
удаленными прижимными 
роликами — 158,975 мм (рис. 3-4). 

 
 
 
 
 
 
 

 
 

Рис. 3-4 
 

 

Регулировка усилия реза в диапазона от 0 до 350 (по умолчанию = 35). 
 

Примечание. При графопостроении пером усилие реза установить на минимальное 
значение. Это позволяет избежать стертых линий и продляет срок службы пера. 

Poll Size (замер рабочей области) 

Blade Force (усилие реза) 
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 

Выбор держателя ножа — пластмассового (по умолчанию) или металлического. 
 
 
 

Выбор одного из двух вариантов: тяжелый или легкий (по умолчанию). 
 
 
 

Регулировка смещения ножа для обеспечения качества резки. 8 вариантов: 0,000; 
0,175; 0,250 (по умолчанию); 0,275; 0,300; 0,500; 0,750 и 1,000. 

 
 

 

Настройка и изменение смещения AAS. 
Подробнее см. «5.3. Тестирование печати». 

 

 
 
 

 

Переключение между листовыми и рулонными материалами (по умолчанию 
включено). 

 
 
 

Для применения измененных настроек плоттера нажать кнопку Update. 

Blade Holder (держатель ножа) 

Media Weight (плотность материала) 

Blade Offset (смещение ножа) 

AAS Offset (смещение AAS) 

Auto Unroll (автоматическая размотка) 

Update (обновление) 
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3.2.3 Сброс до заводских настроек по умолчанию 
В программе VLCD предусмотрен сброс всех параметров меню до заводских настроек. 

 
 

Шаг 1 Войти в режим переключения порта USB, переключив режим: On/Off line( 1) > 
Pause (2) > Origin Set (3). 

 

 
 

Шаг 2 Нажать клавишу «влево» (4), затем «вверх» (5). 
 

 
 
 

Шаг 3 Запущен режим очистки и восстановления данных по умолчанию. 
Нажать Data clear (6), подтвердить кнопкой Origin Set (7). 

 

 
 

Шаг 4 Процесс восстановления настоек по умолчанию завершен. Плоттер 
перезагружается, поэтому никакие кнопки не действуют. 

 

 

Шаг 5 Теперь плоттер можно снова включить. 
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3.3 Загрузчик файлов 
 

3.3.1 Установка 
 Инструмент File Uploader предназначен для загрузки файлов с отправкой 

задания напрямую. 
 Программа поддерживает ТОЛЬКО файлы формата HPGL, созданные через 

драйвер режущего плоттера GCC. 
 Для установки скопировать файл Uploader.exe из папки Accessories 

установочного компакт-диска Expert II на локальный жесткий диск. 
 Запустить VLCD двойным щелчком на значке программы (рис. 3-5). 

 

  
Рис. 3-5 Рис. 3-6 

 
 
 
 
 
 

3.3.2 Функции загрузчика файлов 
 
 
 

 Функция активируется при выбора COM порта для передачи данных. 
 Нажать кнопку Port setup. Откроется окно настройки параметров (рис. 3-6). 

 
 

 Для активации установить флажок Repeat. 
 Repeat Delay — задержка между заданиями, единица: секунда. 
 Repeat Counts — количество повторов задания. 

Port setup (Настройка порта) 

Repeat (Повтор) 
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3.4 Передача данных 
 

Передать данные с компьютера на режущий плоттер можно двумя способами: 
Вариант 1. При правильно настроенных параметрах можно передавать данные 

из программы прямо на режущие плоттеры. 

 
Вариант 2. Практически все программы поддерживают эмуляцию команд HP-GL и HP-

GL/2. Если файл в формате HP-GL или HP-GL/2, ошибки при выводе 
на режущем плоттере исключены. 

 
3.5 Настройка драйвера печати Expert II 
3.5.1 Настройка драйвера печати Expert II > Вкладка Option 

 
• File Function. Функция позволяет сохранять ранее заданные параметры скорости, 

усилия, смещения и качества. При повторяющихся работах это позволяет 
сохранить самые распространенные настройки и загружать их по мере 
необходимости 
 

• Custom Media. Раздел содержит список недавно созданных и использованных 
файлов с параметрами настройки. Для удобства работы можно сохранять более 
50 файлов. 

 
• Default. В разделе содержатся эталонные настройки для проверенных материалов, 

обеспечивающие наилучшие результаты резки. Рекомендованные параметры могут 
нуждаться в корректировке в зависимости от поставщика материалов. 

 
• SAVE. Сохраняет текущие настройки драйвера печати в файл в указанной папке 

компьютера. (Сохраненные файлы с параметрами помечаются расширением серии 
Expert II) 

 
• LOAD. Загружает ранее сохраненные параметры драйвера печати. 

 

• ORIGINAL. Загружает исходные заводские параметры драйвера печати. 
 

• SAVE TO DEFAULT. Сохраняет текущие параметры драйвера печати как исходные 
параметры по умолчанию. 

 
• DELETE. Удаляет выбранный файл из раздела Custom Media. Настройки в разделе 

Default удалить невозможно. Внимание: функция удаляет только список, показанный 
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в разделе Custom Media, не затрагивая файл на жестком диске. Удалить файл 
с жесткого диска можно только вручную через операционную систему. 

 
Die Cut 
Функцию высечки активируют вместе с функцией Kiss Cut (Надсечка), 
чтобы материал после резки не падал и не собирался под кареткой. В режиме Die cut 
прорезается подложка материала, в режиме Kiss Cut прорезается только верхний слой, 
но не подложка. Соответственно, на верхнем слое остаются только небольшие 
фрагменты подложки, а на листах подложки воспроизводится весь макет 
(рис. 3-7 и 3-8). 

 
 
 
 
 

Рис. 3-7 
 

 

Рис. 3-8 

 Линия реза 

Винил 
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Для активации функции Die Cut перейти в меню Option, установить флажок Die Cut 
и ввести нужные параметры Length (Длина) и Force (Усилие) для высечки и надсечки. 
Подтвердить кнопкой OK (рис. 3-9). 

 
 
 
 
 
 
 
 
 
 
 
 

* Примечание. 
Длина линии реза для 
высечки составляет от 0 
до 2000 мм, для надсечки — 
от 0 до 100 мм. 

 
 

Рис. 3-9 
 

По окончании задания, когда флажок Die Cut снова будет снят, можно отрегулировать 
стандартную скорость пера, усилие прижатия пера и смещение в разделе сверху 
(см. рис 3-10). 

 
 
 
 
 
 
 
 

Примечание. 
1. Сначала необходимо задать высоту 
ножа для прорезания верхнего слоя 
и подложки. После этого отрегулировать 
усилие реза для получения оптимальных 
результатов. 
2. После активации функции Die Cut она 
будет применена ко всем линиям 
объекта. 

 
Рис. 3-10 
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3.6 Рекомендованные настройки для различных материалов 
Параметры ниже используются для материалов из таблицы, сертифицированных GCC. 

 

 
Материал Наклейки под заказ / 

на стены 
Наклейки на 
автомобили Витринный декор Тонирование 

витрин 

Нож красный красный красный красный / желтый 

Длина лезвия, мм 0,28 0,27 0,25 0,09 

Усилие, гс 105 85 95 70 

Скорость, см/с 72 60 65 72 

Смещение, мм 0,25 0,25 0,25 0,25 
 
Рекомендованная 
модель 

RX, Jaguar, Puma 

EX, AR 

RX, Jaguar, Puma 

EX, AR 

RX, Jaguar, Puma 

EX, AR 

RX, Jaguar, Puma 

EX, AR 

Материал Трафарет Светоотражающая  
пленка 

Флок Картон 

Нож красный / зеленый зеленый зеленый зеленый 

Длина лезвия, мм 0,3 0,5 0,3 0,3 

Усилие, гс 180 380 135 165 

Скорость, см/с 15 3 30 30 

Смещение, мм 0,25 / 0,5 0,5 0,5 0,5 
 
Рекомендованная 
модель 

RX, Jaguar, Puma 

EX, AR 

RX, Jaguar, Puma 

EX 

RX, Jaguar, Puma 

EX, AR 

RX, Jaguar, Puma 

EX, AR 

Материал Магниты Тонировочная 
защита 

Стразы Маска для 
пескоструйки 

Нож зеленый зеленый зеленый синий 

Длина лезвия, мм 0,8 0,3 0,8 0,27 

Усилие, гс 580 320 190 85 

Скорость, см/с 3 3 15 60 

Смещение, мм 0,5 0,5 0,5 0,25 
 
Рекомендованная 
модель 

 
RX, Jaguar 

RX, Jaguar, Puma 

EX 

 
RX, Jaguar, Puma 

RX, Jaguar, Puma 

EX, AR 

Материал Мелкий текст 
(винил) 

   

Нож черный    

Длина лезвия, мм 0,27    

 
Усилие, гс 

толстый: 150 

тонкий: 90 

   

Скорость, см/с 9    

Смещение, мм 0,175    

Рекомендованная 
модель 

RX, Jaguar, Puma    
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В этом разделе рассмотрено базовое техническое обслуживание режущего 
плоттера, включая очистку. Все процедуры, не вошедшие в перечень ниже, 
выполняются только квалифицированным сервисным специалистом. 

 
 

4.1 Очистка режущего плоттера 
 

Для поддержания высоких эксплуатационных характеристик режущего плоттера 
и обеспечения качественных результатов устройство требует тщательной регулярной 
очистки. 

 
 

 
 

 Перед очисткой режущий плоттер отключить от розетки 
электросети. 

 Запрещается использовать для очистки растворители, 
абразивные чистящие средства и агрессивные моющие 
составы. Они могут повредить поверхность режущего 
плоттера и движущиеся части. 

 
 

 
 
 Осторожно протереть поверхность режущего плоттера безворсовой тканью. При 

необходимости очистить тканью, смоченной в воде или спирте. Протереть режущий 
плоттер, удалив остатки загрязнений. Остатки воды просушить мягкой безворсовой 
тканью. 

 Протереть направляющую каретки от пыли и грязи. 
 Удалить грязь и остатки материала из-под корпуса прижимного ролика с помощью 

пылесоса. 
 Очистить опорную пластину, датчики бумаги и прижимные ролики тканью, 

смоченной в воде или спирте. Остатки воды просушить мягкой безворсовой 
тканью. 

 Аналогичным способом очистить от пыли и грязи стойку. 

Рекомендованные процедуры: 

Меры предосторожности при очистке: 

 
Раздел 4. Базовое техническое обслуживание 
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4.2 Очистка решетчатого барабана 
 
 Режущий плоттер отключить, каретку отодвинуть от очищаемой области. 
 Поднять прижимные ролики и отодвинуть от решетчатого барабана. 
 Жесткой щеткой (можно зубной) очистить поверхность барабана от пыли. При 

необходимости в процессе очистки проворачивать барабан вручную (рис. 4-1). 
 
 
 

 
 
 
 

4.3 Очистка прижимных роликов 
 

Если прижимные ролики нуждаются в очистке, удалять загрязнения с обрезиненной 
части роликов следует безворсовой тканью или тупфером. Чтобы прижимные ролики 
не проворачивались при очистке, придерживать ролики пальцем. 

 
Въевшиеся и стойкие загрязнения удалять безворсовой тканью или тупфером, 
смоченными в спирте. 

Рис. 4-1 
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AAS II (Система автоматического выравнивания II) доступна только в моделях Expert 
II LX. Пользователи плоттеров Expert II 24 и 52 могут пропустить этот раздел. 

Внимание! Этот раздел представляет собой вводную инструкцию к AASII. Пошаговые 
инструкции приведены в следующих разделах: 07_A-4 Модуль CorelDRAW, 07_A-5 
Модуль Illustrator, 07_A-6 Модуль GreatCut. 

 
5.1 Общая информация 

 
Режущие плоттеры Expert II укомплектованы стандартной системой автоматического 
выравнивания (AAS II), которая распознает приводочные метки на отпечатках, 
гарантируя точность реза. 

 
Внимание 
 Избегать горизонтального освещения модуля AAS любым источником света. 

 
 
 
 
 
 
 
 
 

- ЗАПРЕЩАЕТСЯ - РАЗРЕШЕНО 
 

 ЗАПРЕЩАЕТСЯ снимать крышку модуля AAS в процессе работы. 
 

 

- ЗАПРЕЩАЕТСЯ 

Раздел 5. Автоматическое выравнивание 
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5.2 Система контурной резки AAS 
 
Исключительная точность работы системы AAS обеспечивается специальными 
калибровочными процедурами. Для работы с системой AAS необходимо уметь 
загружать материал. (см. «2.4. Загрузка материала».) 

 
5.2.1 Примечание по приводочным меткам 

Первая приводочная метка должна отличаться, чтобы ее распознавала система 
AAS. На автоматическое считывание меток влияют следующие факторы: 

 Тип материала 
 Расположение приводочных меток 
 Диапазон считывания для распознавания приводочных меток 
 Положение приводочных меток и материала  

Приводочные метки должны быть: 
 созданы в программе для резки типа GreatCut или модуля GCC для 

CorelDRAW; 
 черного цвета (важно качество печати приводочных меток: неверные 

цвета, проблемы приводки, размытие, размазывание могут ухудшить 
результаты резки) 

 Length: длина меток 
  Диапазон: от 5 до 50 мм 
 Оптимально: 25 мм 

 Thickness: толщина линии меток 
  Диапазон: от 1 до 2 мм 
 Оптимально: 1 мм 

 Margin: расстояние между метками и изображениями 
  Диапазон: от 0 до 50 мм 
 Оптимально: 5 мм 

Режущий плоттер не распознает метки, если: 
 Перед распознаванием каретку плоттера не подвели к внешней 

границе первой метки (зону автоматического распознавания первой 
приводочной метки см. на рис. 5-7.). 

 Средняя толщина более 0,8 мм. 
 Используется прозрачный материал. 
 Рисунок не монохромный. Отпечатанные на цветной поверхности 

метки не считываются. 
 Поверхность материала испачкана или измята. 
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5.2.2 AAS II для Expert II 
В AAS II есть три схемы работы с метками: 4-Point Positioning (по 4 точкам), Segmental 
Positioning (по сегментам), Multiple Copies (создание копий). Перед печатью макетов на 
струйном принтере необходимо добавить к макету приводочные метки, созданные в 
программе для резки типа SignPal, GreatCut или модуля GCC для CorelDRAW. Режущие 
плоттеры GCC не работают с рисунками и метками, сделанными от руки. 
Подробнее о настройке приводочных меток в программе резки см. «Приложение A-4: 
Инструкция по программному модулю CorelDraw», «Приложение A-5: Инструкция по 
программному модулю Illustrator», «Приложение A-6: Модуль GreatCut». 

 
1. Позиционирование по 4 точкам 

Базовая схема автоматического распознавания приводочных меток в AAS II и 
контурной резки изображений внутри этих меток. 
 Команда: Esc.D1;(XDist);(YDist): 
 Компоновка: 4 приводочные метки по четырем углам вокруг макета. 

 

 
2. Позиционирование по сегментам 

К четырем исходным точкам добавляются промежуточные приводочные метки по 
осям X и Y для большой точности резки, особенно крупных изображений. 
 Команда: Esc.D2;(XDist);(YDist);(XStep);(YStep): 
 Компоновка: 

Промежуточное расстояние по оси X: от 200 до 600 мм, по умолчанию 300 мм 
Промежуточное расстояние по оси Y: от 200 до 600 мм, по умолчанию 300 мм 

 

 
 
 
3. Создание копий 

Функция используется для дублирования изображений, позволяя вырезать сразу 
несколько экземпляров. Датчик AAS II автоматически отсканирует приводочные метки 
для каждого отдельного изображения, обеспечив точность реза. 
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 Команда: Esc.D3;(XCopies);(YCopies);(Space): 
 Компоновка: 

 

 
 
5.3 Пробная печать 

 
Перед выполнением контурной резки с системой AAS рекомендуется распечатать 
тестовый файл с установочного диска DVD, чтобы обеспечить точность реза на 
Expert II. 

 
Для AASII предусмотрено два тестовых файла: 
1. AAS II_X_Y_Offset_Caberation_A4.eps (формат A4) 
2. AAS II_X_Y_Offset_Caberation_600_600.eps (по умолчанию, рекомендован 

для тестирования) 
 Распечатать тестовое изображение. (Рекомендован принтер с высокой 

точностью печати) 
 Загрузить изображение в Expert II и отправить файл на резку для 

тестирования 
 Если необходимо внести корректировки, отредактировать величину 

смещения, как описано ниже: 
■ Замерить величину смещения отпечатанной линии и линии реза. 
■ Ввести значение AAS Offset в разделе MISC с учетом полученных 

значений, затем нажать Enter 
■ Повторно протестировать резку 
■ Величину смещения по осям X и Y для AAS II определяют следующим 

образом: 
Горизонтальная линия — X, вертикальная линия — Y (лицом к 
режущему плоттеру) 

■ Если нужно сместить линию реза и отпечатанную линию по 
направлению к исходной метке, указывают отрицательное значение 
смещения. Если нужно сместить линию от исходной метки, вводят 
положительное значение смещения (см. рис. ниже). Это относится 



Автоматическое выравнивание 5-5 

Expert II. Руководство 
 

 

 
  

 

к осям X и Y. 

 
Примечание: 

 Перед изменением настроек AAS II выполняют масштабирование 
по ширине и длине. 

 Для тестового изображения смещение ножа не задано. 
Его настраивают в зависимости от выбранного ножа. 

 С вопросами обращаться к нам или к местному дистрибьютору. 
 
 
 
 

5.4 Допустимое смещение приводочных меток 
 

Чтобы система распознала приводочные метки, необходимо следить 
за правильностью загрузки материала (по приводочной линейке на опорной пластине). 
При отклонениях, выходящих за приведенный диапазон, метки распознаны не будут. 
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5.5 Контурная резка 
 
Для точности контурной резки с функцией AAS выполнить следующие шаги: 

 
 
Шаг 1 Создание графики 

■ Создать изображение, которое нужно отпечатать и вырезать через программу. 
 

 

■ Создать контур реза вокруг изображения. 
 

 
Совет 1. Оставлять место между изображением и контурной линией. 
Совет 2. Создавать контур в отдельном слое и присваивать ему другой цвет. 

■ Добавить приводочные метки вокруг изображения. 
 
 

Примечание. 
Можно воспользоваться функцией Multiple Copies. Она автоматически 
копирует изображение и приводочные метки. 
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Шаг 2 Разместить приводочные метки 
 Макет в AAS: 

 

 
* Функция автораспознавания на 1й

 метке охватывает серую зону. 
 Рекомендуемые поля в 30 мм слева и справа от листа материала. 
 Рекомендованы поля от верхней кромки листа от 20 до 30 мм, от нижней 
кромки — не менее 50 мм во избежание падения листа и на случай ошибки 
в размерах материала. 

 
Шаг 3 Отпечатать графику 

■ Отпечатать на принтере изображение и метки. 

(масштаб = 100 %)  
■ При печати на рулоне придерживаться следующей ориентации: 
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Шаг 4 Загрузить отпечаток в режущий плоттер 

■ Исходная метка должна отличаться от остальных приводочных меток. 
Необходимо проверить правильность направления подачи. 

 

  

Шаг 5 Вырезать контур 
■ Через программу дать команду выполнить задание на резку. 

 
 
 
5.6 Советы по AAS 

 
Чтобы результаты контурной резки были лучше, придерживаться следующих 
правил. 

 Работать с простыми источниками освещения, не освещать плоттер сбоку. 

 Перед запуском системы AAS изменить максимальный формат 
бумаги в свойствах драйвера Expert II. 
Шаг 1 В папке Printer & Fax на компьютере найти модель Expert II. 

Шаг 2 Открыть окно Properties (Свойства) и выбрать вкладку Paper (Бумага). 

Шаг 3 Изменить максимальный размер бумаги по оси X на 1200 мм. 

 Скорость резки установить в диапазоне 200–400 мм/с. 

 Проследить, чтобы прижимные ролики не закрывали приводочные метки. 

 При распознавании приводочных меток убедиться, что материал не загнут. 
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В этом разделе рассмотрены распространенные проблемы в процессе 
эксплуатации плоттера. Перед тем как знакомиться с содержимым раздела, 
убедитесь, что ваша программная среда совместима с режущим плоттером. 

 
 

 
 
 
 

Почему не работает режущий плоттер? 
 
 
 
 

6.1 Почему Expert II не работает? 
 

Если режущий плоттер не работает, сначала проверить следующее: 
 

 
 

Решения: Если светодиодный индикатор питания горит, режущий плоттер исправен. 

Отключить и повторно включить режущий плоттер. Проверить, сохранилась ли 
проблема. 
Если светодиодный индикатор питания не горит, свяжитесь с локальным 
дилером для решения проблемы. 

6.2 Световые индикаторы 
 

Световые индикаторы на панели управления помогут выявить некоторые проблемы 
с эксплуатацией. 

Если режущий плоттер прекратил работу или внезапно замигали световые индикаторы, 
ознакомиться с описаниями сигналов ниже и с необходимыми действиями: 

Правильно ли подключен кабель питания? 
Правильно ли подключен кабель питания к источнику питания? 
Положение силового выключателя правильное? 

Примечание. 
Перед тем как связываться с локальным дилером, убедиться, что проблема в режущем 
плоттере, а не в обмене данными между компьютером и режущим плоттером и не в 
отказе компьютера либо программного обеспечения. 

 
Раздел 6. Поиск и устранение неисправностей 
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6.2.1 Предупредительные индикаторы 
 

Если мигает индикатор ERROR, выполнить следующие действия. При устранении 
проблемы индикатор автоматически прекращает мигать. Отключить индикатор 
ERROR также можно кнопкой ON/OFF LINE. 

 

 
 

= мигает = вкл. = откл. 
 
 

Предупреждение 1 Обрезан макет 

Указывает, что макет больше области реза. 
 

Чтобы решить проблему: 
1. Загрузить более широкий или длинный материал. 
2. Переместить прижимные ролики, увеличив область реза. 
3. Уменьшить макет масштабированием. Снова отправить макет с компьютера 

на режущий плоттер. 
 
 
 

Предупреждение 2 Ошибка команды HPGL/2  
Если режущий плоттер не распознает команды HP-GL/2 или HP-GL, проверить 
правильность применения команд HP-GL/2 или HP-GL к режущему плоттеру. Снова 
отправить макет с компьютера на режущий плоттер. 

 
Если проблема не решена, связаться с локальным дилером. 

 
 

Предупреждение 3 Поднят рычаг или нет материала 
Перед началом резки убедиться, что рычаг опущен, а материал загружен. 

 
Предупредительные индикаторы 

 
ERROR 

ON/OFF 

LINE 

 
REPEAT 

DATA 

CLEAR 

CUT 

TEST 

1 Обрезан макет 

2 Ошибка команды HPGL/2 

3 Поднят рычаг или нет материалов 

4 Повтор невозможен 

5 Ошибка передачи данных 

6 Ошибка датчика ширины 

7 Материал, барабан, привод по оси X 
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Предупреждение 4 Повтор резки невозможен 

Есть два варианта. 
1. В буфере нет данных: необходимо снова отправить задание с компьютера. 
2. Буфер переполнен: необходимо снова отправить задание с компьютера. 
В обоих случаях сообщение об ошибке отключается нажатием кнопки ON/OFF LINE. 

 
 

Предупреждение 5 Ошибка передачи данных 

Проверить, правильно ли подключен к режущему плоттеру и компьютеру кабель 
последовательного интерфейса (USB). 
Если да, проверить правильность настроек интерфейса. Настройки передачи данных в 
компьютере должны быть теми же, что на режущем плоттере (пример: 9600bps, no 
parity, 8 bits, 1 stop bit). После этого вернуться в рабочий режим кнопкой ON/OFF LINE. 

 
Предупреждение 6 Ошибка датчика ширины 

Проверить, находятся ли прижимные ролики над решетчатым барабаном, и снова 
загрузить материал. 

 

 

6.2.2 Индикаторы ошибок 

При возникновении механических неполадок в процессе работы загорается 
светодиодный индикатор ERROR. Для решения проблемы выполнить перечисленные 
ниже шаги. Если режущий плоттер по-прежнему не работает, связаться с локальным 
дилером и сообщить об индикаторе ошибок. 

 
= мигает = вкл. = откл. 

 

Примечание. 
Чтобы легко определять тип ошибки, рекомендуется приклеить с боковой 
стороны режущего плоттера наклейку с предупреждениями (из коробки 
с дополнительными компонентами). 
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Ошибки 1 и 2 

Связаться с локальным дилером для замены SRAM или DRAM. 

 

Ошибка 3 Проверить материал, барабан, привод по оси X (привод барабана) 

В сообщении указывается, что проблема может быть по оси X. 

Проверить функционирование барабанов и загрузку материала. После этого включить 
питание и перезагрузить режущий плоттер. 

 

Ошибка 4 Проверить материал, барабан, привод по оси Y (привод каретки) 

В сообщении указывается, что каретке может что-то мешать на оси Y. 

Удалить помеху и убедиться, что каретка перемещается свободно. После этого 
включить питание и перезагрузить режущий плоттер. 
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6.3 Снижение качества резки 
 
 

 
 
 

 
 
 

Примечание. Очень важно обслуживать режущий плоттер 
ежедневно. Для точности и качества резки решетчатый барабан 
и прижимные ролики нуждаются в регулярной очистке.  
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Номер модели: EX II-24 EX II-24LX EX II-52 EX II-52LX 
Ширина реза, до 600 мм 1320 мм 
Ширина материала, до 719 мм 1470 мм 
Толщина материала 0,8 мм 
Усилие реза, до 350 гс 

Скорость реза, до 705 мм/с (под углом 45°) 635 мм/с (под углом 45°) 
Физическое разрешение 0,009 мм 0,012 мм 
Экранное разрешение 0,025 мм 
Точность перемещения ±0,254 или ±0,1% хода, по большей величине 
Повторяемость ±0,1 мм 
Отслеживание 3 м 
Буфер памяти 1 МБ / 500 KБ (при использовании AAS) 
Интерфейсы USB 2.0 (полноскоростной), RS-232 
Тип команд HPGL, HPGL/2 
Настройка исходной точки Да 
Панель управления 6 светодиодов / 10 кнопок 
Диаметр ножа 2,5 мм 
Габариты (В х Ш х Г), мм 233 х 880 х 255 1065 х 1632 х 620 
Масса нетто 11 кг 53 кг 
Стойка Дополнительно Стандарт 
Система автоматического  

  выравнивания (AAS II) Для моделей Expert II LX 

  Источник электропитания 100–240 В переменного тока, 50/60 Гц (автопереключение) 
  Энергопотребление Не более 288 Вт 
Условия 
эксплуатации 

Температура от +15 °C до +30 °C 
Влажность От 25 % до 75 % 

 
 Совместимость с ОС Windows 7 и выше, MAC OS X 10.6 и выше. (* При 

приобретении серийного номера ПО Sure Cuts A Lot, работающего с Mac OS.) 
 Спецификации и технические характеристики могут отличаться в зависимости от 

материала. Для оптимальных результатов рекомендуется проводить надлежащее 
систематическое техобслуживание устройства. 

 GCC оставляет за собой право на изменение технических характеристик без 
предварительного уведомления. 

 Данные приведены для материала Avery MPI 3000, сертифицированного GCC. 
 Приведенные выше технические характеристики действительны только при работе с 

материалами, сертифицированными GCC. 
 
 
 

 

 

Технические характеристики серии Expert II 
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202003480G 

Для резки толстого флуоресцентного и светоотражающего винила. 
Также для работ из стандартного винила с мелкими деталями. 

 45°, красная насадка (5 штук в упаковке), смещение 0,25 мм,  
диаметр лезвия 2,5 мм. 

 

 

 
 

290088080G 

Для резки светоотражающего винила, картона, пескоструйных 
материалов, флока, острых краев трафарета. 

 60°, зеленая насадка (2 штуки в упаковке), смещение 0,50 мм,  
диаметр лезвия 2,5 мм. 

 

 

 
 

265017550G 

Для резки тонких пескоструйных масок и шаблонов. Особая 
конструкция и острый угол заточки для контуров с малыми радиусами. 

 Характеристики ножа: 60°, синяя насадка, смещение 0,25 мм, 
диаметр 2,5 мм. 

 

 

 
 

265017560G 

Для резки мелкого текста и сложных деталей. Острый нож 
с минимальным смещением. 

 Характеристики ножа: 50°, черная насадка, смещение 0,175 мм, 
диаметр лезвия 2,5 мм. 

 

 

 
 

265017530G 

Для тонких и хрупких материалов, включая витринные тонировочные 
пленки. 

 Характеристики ножа: 25°, желтая насадка, смещение 0,25 мм, 
диаметр лезвия 2,5 мм. 

 

 

  

Технические характеристики ножей 
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Об инструменте 
 

Общий термин, обозначающий нож для резки листов, перо для 
графопостроения и светодиодный прицел (дополнительно) для наведения 
на точку привязки. СМЕЩЕНИЕ — расстояние, на которое сдвинуто лезвие 
ножа относительно центральной линии ножа. 

 
 
 
 

Нож 
 
 
 
 
 
 
 
 

 

 
 

Лезвие 
ножа 

Центральная линия 

 

смещение 
 
Вылет ножа 

 
 
 
 
 
 

Вылет ножа 

Толщина 
материала 
(t1) 

 
Толщина бумаги-
основы (t 2) 

 
 
 
 

Вылет, то есть высота, на которую выступает лезвие ножа = t1 + t 2/ 2. Для 
удобства можно считать, что это от 0,3 до 0,5 мм от края держателя. 
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Ниже описана процедура вывода файла из CorelDRAW. 

 

Инструкции для пользователя 
 

1. Открыть CorelDRAW, закончить редактирование всех файлов для вывода и 
выбрать сразу все изображения. 

 
2. Командой Outline Pen задать контур для резки. 

 

 
 

3. Установить значение ширины пера на 0,001 мм и подтвердить кнопкой ОK. 
 

 

Инструкция по выводу из CorelDRAW 
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4. Командой File > Print (Файл > Печать) отправить файл на режущий плоттер. 

 

 
 
 
 

5. Выбрать установленную модель. 
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Вывод из CorelDRAW A-3 

 

 

 
6. На вкладке Layout для опции Reposition images to выбрать вариант: → Bottom left corner 

(Выравнивание по левому нижнему углу”. 

Внимание: изображение должно находиться в нижнем левом углу. 
 

 
 
 

7. Вернуться на вкладку General и проверить, чтобы изображение было в нижнем 
левом углу. Нажать Print (Печать) и получить прекрасно вырезанное изделие. 
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Модуль CorelDRAW A-3 

 

 

 
 

 
 

Программа установки AASII VBA работает с CorelDRAW версий 13, 14, 15, 16, 17, 18 
 

Установка 
Установка программного модуля AAS дляCorelDRAW описана в шаге 8 раздела 2.7.1.2 
«Установка драйвера». 

 
Запуск программного модуля CorelDRAW AAS 

 

Шаг 1 Запустить CorelDRAW для редактирования графики и выделить сразу все 
изображения для отправки на плоттер. 

 
Шаг 2 Запустить макрос командой ToolsMacrosRun Macro. В меню Macros in выделить 

опцию Global Macros (GCCAASII_Draw13.gms) и нажать Run (Выполнить). 
 

 

Инструкция по модулю CorelDRAW 
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Шаг 3 Щелкнуть на кнопке Apply (Применить) и указать тип приводочных меток — 

по размеру страницы или по объекту. 

  

Шаг 4 Теперь можно распечатывать файл с приводочными метками. 
 
 

 
 
 
Для модуля AAS можно добавить значок быстрого запуска 

 

Выполнить Tools  Options  Workspace  Customization  Commands 
 Macros  GCCModule.GCC_AAS_Plug_In и нажать OK. 

 

  

Примечание. При щелчке на изображении по умолчанию выбирается опция 
Add Registration Mark by Object (Добавлять приводочные метки по объекту). 
При щелчке на пустой области страницы по умолчанию выбирается опция 
Add Registration Mark by page size. 
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Добавление приводочных меток по странице 
 

Если установить флажок Add Registration Mark by page size и нажать Apply программа 
автоматически создаст приводочные метки (рис. A3-1). 

  
 

Рис. A3-1 
 

Рис. A3-2 
 
При перемещении изображения программа создает 4 метки на углах страницы, как 
показано ниже. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. A3-3 

Примечание. 
1. Длина в пределах от 5 до 25 мм, 

в зависимости от размера страницы. 

 
2. При добавлении приводочных меток по 
странице, как показано ниже, НЕ ДОПУСКАЕТСЯ 
внесение изменений в раздел Origin во избежание 
смещения меток (см. рис. A3-2). 
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Рабочая область 
Позволяет редактировать и вырезать изображения за границами приводочных меток при 
условии добавления меток по странице. 

 
Для материалов A4 рабочая область на 2,5 мм заходит за приводочные метки с правой 
и левой сторон, на 4,5 мм — за верхнюю метку. Рекомендованное расстояние 
до нижнего края материала — не менее 25 мм во избежание падения листа и на случай 
ошибки в размерах материала. 

 
Для материалов формата A3 рабочая область на 10 мм заходит за приводочные метки 
с левой стороны, на 9 мм — с правой стороны, на 11 мм — за верхнюю метку. 
Рекомендованное расстояние до нижнего края материала — не менее 25 мм 
во избежание падения листа и на случай ошибки в размерах материала. 

 
 
 
 
 

 

Примечание. Для размотки рулона выбрать режим Edge при настройке 
формата материала. При работе в режиме Single лист материала нельзя 
переместить назад, а значит, фронтальный датчик бумаги его не распознает. 
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Добавление приводочных меток по объекту 
 

При установке флажка «Add Registration Mark by Object»на выбор доступно три 
варианта приводочных меток. 

 

 4-Point Positioning (по 4 точкам) 
 Length: длина меток 

  Диапазон: от 5 до 50 мм 

  Оптимально: 25 мм 

 Thickness: толщина линии меток 

  Диапазон: от 1 до 2 мм 

  Оптимально: 1 мм 

 Margin: расстояние между метками и изображениями 

  Диапазон: от 0 до 50 мм 

  Оптимально: 5 мм 
 
 

Segmental Positioning (по сегментам) 

 X Step: расстояние промежуточного положения по оси X 

 Y Step: Расстояние промежуточного положения по оси X 

  Диапазон: от 200 до 600 мм 

  Оптимально: менее 500 мм 
 
 
 
 
 
 

Рис. A3-4 

Multiple Copies (Создание копий) 

 No. of X Copies: количество копий по оси X 

 No. of Y Copies: количество копий по оси Y 

  Диапазон: от 1 до 50 (чем больше копий, тем 

больше времени нужно на передачу данных). 

  Количество копий X * количество копий Y = общее 

количество копий изображения 

 Сopies with outline: для отображения контуров 
изображения 

 
 

 

Примечание. Значения, указанные в разделе 4-Point Positioning (длина, 
толщина, поля), действительны также с установленными флажками Segmental 
Positioning и Multiple Copies. 
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Позиционирование по 4 точкам 

 
 

4-Point Positioning 

 Length: длина меток 

  Диапазон: от 5 до 50 мм 

  Оптимально: 25 мм 

 Thickness: толщина линии меток 

  Диапазон: от 1 до 2 мм 

  Оптимально: 1 мм 

 Поля: Расстояние между метками и изображениями 

  Диапазон: от 0 до 50 мм 

  Оптимально: 5 мм 
 
 
 
 
 
 
 

Рис. A3-5 
 
 
Программа создаст 4 метки, как показано на рисунке ниже. 

 

 
 

Рис. A3-6 
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Примечание. 
1. Для экономии материала при позиционировании по 4 точкам допускается менять 

не только поля объекта, но и длину приводочных меток (не менее 5 мм). 
Рекомендации для различных форматов см. в таблице 1. Чем меньше размер, тем 
меньшим должно быть расстояние между объектом и приводочной меткой 
(см. расчеты ниже). 

 
 
 
 
 

Область реза 
 
 
 

Рис. A3-7 Рис. A3-8 
 
 
 
 
 
 

Формат страницы, в мм Рекомендуемая длина метки, в мм 

A6 (105 × 148) 5 
А5 (148 × 210) 8 
А4 (210 × 297) 11 
А3 (297 × 420) 16 
А2 (420 × 594) 23 
А1 (594 × 841) и более 25* 

Таблица 1 
*25 мм — рекомендованная длина приводочной метки 

 

2. Размер приводочных меток влияет на точность распознавания, поэтому не следует 
делать их слишком мелкими 

 
3. При изменении формата бумаги необходимо указать новые значения для 
приводочных меток, иначе применяются текущие настройки. 



Expert II. Руководство 

Модуль CorelDRAW A-3 

 

 

 
Позиционирование по сегментам 

 

Для высокоточной резки рекомендуется выбрать режим 
Segmental Positioning, повысив точность обработки 
длинных и крупноформатных изображений. 

 
 
 
 
 

Позиционирование по сегментам 

 X Step: расстояние промежуточного положения по оси X 

 Y Step: расстояние промежуточного положения по оси X 

  Диапазон: от 200 до 600 мм 

 Оптимально: менее 500 мм 
 
 
 
 

Рис. A3-9 
 
Программа создаст метки, как показано на рисунке ниже. 

 

 
 

Рис. A3-10 
 
При копировании объектов больших размеров (длина либо ширина более 200 мм) 
с функцией Multiple Copies к ним применяется позиционирование по сегментам — 
для более точного распознавания приводочных меток. 

По сегментам 
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Создание копий 
Переключатель Multiple Copies повышает точность реза в случаях, когда из материала 
необходимо получить несколько экземпляров одного изображения. 

 
 
 
 
 
 
 
 

Создание копий 

 No. of X Copies: количество копий по оси X 

 No. of Y Copies: количество копий по оси Y 

  Диапазон: от 1 до 50 (чем больше копий, тем 

больше времени нужно на передачу данных). 

  Количество копий X * количество копий Y = 

общее количество копий изображения 

 Сopies with outline：для отображения контуров 

изображения 
 
 

Рис. A3-11 
 

Программа создаст результат, как показано на рисунке ниже. 
 

 
Рис. A3-12 

ось Y 

ось X 
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Контурная резка через CorelDraw 
Шаг 1 Поместить в плоттер GCC бумагу с приводочными метками, отпечатанными 
на принтере. 
Шаг 2 Выполнить Files  Print. 

 

 
 
 
Примечание. 
Для CorelDraw версии Х5 и выше выполнить описанные ниже шаги. 

Рис. A3-13 

 

Шаг 1 На вкладке «Color» в поле Color conversions performed by: (Выполнить 
преобразование цвета в:) указать модель плоттера (см. рис. А3-14). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. A3-14 
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Шаг 2 На вкладке Layout для опции Reposition images to выбрать вариант Bottom left 

corner (Выравнивание по левому нижнему углу). 

   Рис. A3-15   
 
Шаг 3 Нажать кнопку Print. 
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Установщик AASII VBA работает с Adobe Illustrator версий CS4, CS5, CS6, CC. 
 

Установка 
Установка программного модуля AAS для Adobe Illustrator описана в шаге 8 раздела 2.7.1.2 
«Установка драйвера». 

 
Настройка принтера 

 

Шаг 1 Открыв окно принтеров через Панель управления, щелкнуть правой кнопкой 
мыши на принтере и выбрать Printer Properties. Откроется диалоговое окно свойств 
принтера. 

 

 

Инструкция по модулю Illustrator 
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Шаг 2 Убедиться, что на вкладке Advanced (Дополнительно) снят флажок Enable 

advanced printing features (Включить дополнительные возможности печати). 
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Инструкции для пользователя 
 

Шаг 1 Открыть Illustrator. 
 

Шаг 2 Отредактировать изображение, создав контурную обводку. 
(Примечание. Ширину линии установить на 0,001 мм). 

 

 
 
 
Шаг 3 Щелкнув на изображении, применить функцию AAS (FileScripts_AASII_Plug_In). 

 

 

Линия 
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Шаг 6 Подтвердить приводочные метки (далее в примере рассмотрено 
позиционирование по 4 точкам). 

 
Шаг 4 Выделить нужные приводочные метки. 

 

 
 

Шаг 5 Здесь доступны три типа приводочных меток: 4-Point Positioning (по 4 точкам), 
Segmental Positioning (по сегментам), Multiple Copies (создание копий). 

 
 

 

Примечание. 
Значения, указанные для 4-Point Positioning (длина, толщина, поля), также 
действительны после установки флажков Segmental Positioning и Multiple Copies. 
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Шаг 6 Подтвердить приводочные метки (далее в примере рассмотрено 

позиционирование по 4 точкам). 

 
 

Шаг 7 Щелкнув на пустой области страницы, выбрать Document Setup (Настройка  
документа). 
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Шаг 8 Нажать кнопку Edit Artboards (Редактировать монтажные области). 

 

 

Шаг 9 Выполнить Presets → Fit Artboard to Artwork bounds (Подогнать монтажную область 
по выбранной иллюстрации). 
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Шаг 10 После шага 9 навести мышь на панель инструментов слева и выбрать 

инструмент выделения Selection Tool. 
 

 
 
 
Шаг 11 Режим редактирования снова активен. 
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Шаг 12 Распечатать файл с линией контура и приводочными метками. 

 

 
 
 
Шаг 13 Поместив отпечаток в плоттер, ослабить прижимные ролики и подвести каретку 

к приводочным меткам. 
 
Шаг 14 Отправить файл на плоттер. 
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Шаг 15 Выбрав плоттер, поместить объект в левом нижнем углу. 

 

 
 

Шаг 16 Работа завершена. 
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Добавление приводочных меток по странице 
Чтобы создать метки приводки по размеру страницы, следует выделить объект, 
выполнить команду Scripts из меню File и выбрать AASII_Plug_In. 

 

 
 

 

Примечание. 
Длина метки составляет от 10 до 50 мм, в зависимости от размера страницы. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Установив флажок Make by page size, щелкнуть 
на кнопке Apply (Применить). В четырех углах 
страницы автоматически создаются метки 
приводки, как показано ниже. 
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Рабочая область 
Позволяет редактировать и вырезать изображения за границами приводочных меток при 
условии добавления меток по странице. 

 
Для материалов A4 рабочая область на 2,5 мм заходит за приводочные метки с правой 
и левой сторон, на 4,5 мм — за верхнюю метку. Рекомендованное расстояние до 
нижнего края материала — не менее 25 мм во избежание падения листа и на случай 
ошибки в размерах материала. 

 
Для материалов формата A3 рабочая область на 10 мм заходит за приводочные метки 
с левой стороны, на 9 мм — с правой стороны, на 11 мм — за верхнюю метку. 
Рекомендованное расстояние до нижнего края материала — не менее 25 мм 
во избежание падения листа и на случай ошибки в размерах материала. 

 
 

 

Примечание. Для размотки рулона выбрать режим Edge при настройке формата 
материала. При работе в режиме Single лист материала нельзя переместить 
назад, а значит, фронтальный датчик бумаги его не распознает. 
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Добавление приводочных меток по объекту 
 

При добавлении приводочных меток по объекту на выбор доступно три варианта. 
 

Выделив изображение, которое нужно обозначить метками, выполнить команду Scripts 
из меню File и выбрать AASII_Plug_In. 

 
Флажок Make by page size следует снять, а затем указать нужный тип приводочных 
меток. 
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Три типа приводочных меток 
 

Позиционирование по 4 точкам 
 
 
 
 

4-Point Positioning 
 Length: длина меток 
  Диапазон: от 5 до 50 мм 
 Оптимально: 25 мм 

 Thickness: толщина линии меток 
  Диапазон: от 1 до 2 мм 
 Оптимально: 1 мм 

 Margin: расстояние между метками и 
изображениями 
  Диапазон: от 0 до 50 мм 
 Оптимально: 5 мм 

 
 
 
 
 
 
 
 
 
 
 

Программа создаст 4 метки, как показано на рисунке ниже. 
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Примечание. 
1. Для экономии материала при позиционировании по 4 точкам допускается менять 

не только поля объекта, но и длину приводочных меток (не менее 5 мм). 
Рекомендации для различных форматов см. в таблице 1. Чем меньше размер, тем 
меньшим должно быть расстояние между объектом и приводочной меткой (см. 
расчеты ниже). 

 
 

Область реза 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Формат страницы, в мм Рекомендуемая длина метки, в мм 

A6 (105 × 148) 5 
А5 (148 × 210) 8 
А4 (210 × 297) 11 
А3 (297 × 420) 16 
А2 (420 × 594) 23 
А1 (594 × 841) и более 25* 

Таблица 1 
*25 мм — рекомендованная длина приводочной метки 

 

2. Размер приводочных меток влияет на точность распознавания, поэтому не следует 
делать их слишком мелкими 

 
3. При изменении формата бумаги необходимо указать новые значения для 
приводочных меток, иначе применяются текущие настройки. 
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Позиционирование по сегментам 
Для высокоточной резки рекомендуется выбрать режим Segmental Positioning, повысив 
точность обработки длинных и крупноформатных изображений. 

 
 
 
 

Segmental Positioning 
 X Step: расстояние промежуточного положения 

по оси X 
 Y Step: расстояние промежуточного положения 

по оси X 
 Диапазон: от 200 до 600 мм 
 Оптимально: менее 500 мм 

 
 
 
 
 
 
 
 
 
 

Программа создаст метки, как показано на рисунке ниже. По сегментам  
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Ось Y 

  

 
Создание копий 
Переключатель Multiple Copies повышает точность реза в случаях, когда из материала 
необходимо получить несколько экземпляров одного изображения. 

 
 
 
 
 
 
 

Multiple Copies 
 No. of X Copies: количество копий по оси X 
 No. of Y Copies: количество копий по оси Y 
  Диапазон: от 1 до 50 (чем больше копий, 
тем больше времени нужно на передачу 
данных). 
  Количество копий X * количество копий Y 
= общее количество копий изображения 

 Сopies with outline：для отображения контуров 
изображения 

 Margin: расстояние между метками; должно 
быть 0 или ≧ 20; отрицательные значения не 

допускаются 

Программа создаст результат, как показано на рисунке ниже. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ось X 
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Руководство пользователя программного модуля GreatCut доступно на установочном 
DVD-диске GCC. 

 

Система GCC AASII 

Ниже приведена пошаговая инструкция по работе с функцией AAS в программе GreatCut 
через CorelDRAW и Adobe Illustrator. 

 

Редактирование изображений в CorelDRAW 
 
 
 
Позиционирование по 4 точкам 

Шаг 1 Создать новый файл в CorelDRAW. Нажать на значок Create contour (Создать 
контур) на панели GreatCut — появится автоматически после запуска CorelDRAW. 

 

 

Инструкция по подключаемому модулю GreatCut 
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Шаг 2 Настроить параметры контура, включая смещение контура, и подтвердить кнопкой 
Calculate (Расчет). 

 

  
 
 

К изображениям будут добавлены контурные линии. 
 

 

Смещение контура — 
расстояние между объектом 
и линией контура. 
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Совет: Закругленный контур для векторного объекта 
 

Функция Outline (Контур) повышает качество обработки векторных объектов. 
На острых углах заметна разница между вариантами Normal (Стандарт) и Round 
(Со скруглением). См. рис. ниже: 

 

  
 

Стандарт Со скруглением 

1. Кнопкой Create outline создать вокруг текстовых объектов контуры на свободно 
задаваемом расстоянии. 

 

  
 
 

2. Выбрать Round corners и указать параметры Offset и Tolerance. 
Offset — расстояние между внутренним и внешним контуром исходного 
объекта. В поле Tolerance указано, на каком расстоянии от угловой точки 
скругляется срез. 
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Шаг 3 Нажать значок Settings на панели инструментов GreatCut. 
 

 
 
 
Шаг 4 Нажать кнопку справа от поля Jog marks. 
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Шаг 5 В окне настройки указать размер, расстояние до объекта и толщину линий 
приводочных меток и подтвердить кнопкой ОК. 

Позиционирование по 4 точкам 
 Size Длина меток 
  Диапазон: от 5 до 50 мм 
 Оптимально: 25 мм 

     Object Margin:  
Расстояние между метками 
и изображениями 
  Диапазон: от 0 до 50 мм 
 Оптимально: 5 мм 

 Line thickness: толщина линии 
меток 
  Диапазон: от 1 до 2 мм 
 Оптимально: 1 мм 

 
 
 

Шаг 6 Убедиться, что установлены все три флажка ниже, и нажать ОК. 
 

 

 
 
 

 
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Шаг 7 Нажать значок Set Jog Marks на панели инструментов GreatCut. 
 

 
 
 
Программа создаст 4 метки, как показано на рисунке ниже. 

 

 



Expert II. Руководство 

Модуль GreatCut A-6 

 

 

Примечание. 
1. Для экономии материала при позиционировании по 4 точкам допускается менять не 

только поля объекта, но и длину приводочных меток (не менее 5 мм). Рекомендации 
для различных форматов см. в таблице 1. Чем меньше размер, тем меньшим должно 
быть расстояние между объектом и приводочной меткой (см. расчеты ниже). 

 
 

Формат страницы, в мм Рекомендуемая длина метки, в мм 

A6 (105 × 148) 5 
А5 (148 × 210) 8 
А4 (210 × 297) 11 
А3 (297 × 420) 16 
А2 (420 × 594) 23 
А1 (594 × 841) и более 25* 

Таблица 1 
*25 мм — рекомендованная длина приводочной метки 

 

2. Размер приводочных меток влияет на точность распознавания, поэтому не следует 
делать их слишком мелкими
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Вывод 
Шаг 1 Выбрать объект целиком, включая приводочные метки и линию контура, и нажать 

значок Cut на панели инструментов GreatCut. 

 

Шаг 2 Система автоматически активируется и запустит импорт приводочных меток 
и линии контура в GreatCut. 
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Шаг 3 Из меню File выбрать команду Output (Вывод). 

 

 
 
 

Шаг 4 В окне выбора устройства Output to device в поле Mode/Tool указать Cut with AAS. 
 

 

Указать остальные 
параметры: AAS Offset, 
Pressure, Speed, Material 
width и пр. 
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Шаг 5 Нажать Output — объект будет отправлен на режущий плоттер GCC. 
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Примечание. Разница между параметрами Number of outputs, Number of copies и Step 
count в окне Output. 

 

 
 

 
1. Значение параметра Number of outputs — 2: квадрат и треугольник 

вырезаются 1 раз, а затем обе фигуры вырезаются 1 раз в следующей 
позиции. 

 
2. Значение параметра Number of copies — 2: квадрат и треугольник вырезаются 

2 раза в той же позиции. 
 

3. Значение параметра Step count — 2: квадрат вырезается 2 раза в одной 
позиции, треугольник вырезается 2 раза в одной позиции. 
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Расширенная настройка 
 

Позиционирование по сегментам 
Для высокоточной резки рекомендуется выбрать режим Segmental Positioning, повысив 
точность обработки длинных и крупноформатных изображений. 

 
Для настройки линии реза и создания приводочных меток повторить шаги из раздела 
Позиционирование по 4 точкам. В окне настройки указать размер, расстояние от меток 
до объекта, толщину линий приводочных меток, расстояние между метками 
и подтвердить кнопкой ОК. 

 
Шаг 1 Нажать значок Settings на панели инструментов GreatCut. 
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Шаг 2 Нажать кнопку справа от поля Jog marks. 
 

 
 
 

Шаг 3 В окне настройки указать размер, расстояние до объекта и толщину линий 
приводочных меток и подтвердить кнопкой ОК. 

 
 
 
 
 
 

Позиционирование по сегментам 
 Max. x Distance: расстояние 

промежуточного положения 
по оси X 

  Диапазон: от 200 до 500 мм 
 Max. y Distance: расстояние 

промежуточного положения 
по оси X 

  Диапазон: от 200 до 500 мм 
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Шаг 4 Убедиться, что установлены все три флажка ниже, и нажать ОК. 
 

 
 
 
Шаг 5 Нажать значок Set Jog Marks на панели инструментов GreatCut. 

 

 

 
 
 

 
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Программа создаст метки, как показано на рисунке ниже. 
 
 
 

Позиционирование по сегментам 
 
 
 
 
 
 

Ось Y 
 
 
 
 
 
 
 
 

Ось X 
 
 

Для отправки файла на режущий плоттер GCC повторить шаги из раздела Вывод. 
 
 
 
Создание копий 

 

Шаг 1 Для настройки линии реза и создания приводочных меток повторить шаги из 
раздела Позиционирование по 4 точкам. 

 
 
 
 
 
 
 
 

При работе с функцией 
Multiple Copies применяются 
параметры, указанные в этом 
разделе. 



Модуль GreatCut A-6 

Expert II. Руководство 
 

 

Шаг 2 Нажать значок Set Jog Marks на панели инструментов GreatCut: будут созданы 
4 метки, как на рисунке ниже. 
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Шаг 3 Выбрать объект целиком, включая приводочные метки и линию контура, и нажать 
значок Cut на панели инструментов GreatCut. 

 
 
 
Шаг 4 Система автоматически активируется и запустит импорт приводочных меток 

и линии контура в GreatCut. 
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Шаг 5 Из меню File выбрать команду Output (Вывод). 
 

 
 
 
Шаг 6 В поле Mode выбрать Cut with AAS, указать количество изделий по осям X 

и Y, расстояние между копиями. Кнопку Output не нажимать. 

 
 
Шаг 7 Вернуться в CorelDRAW. Выполнить File > GreatCut > Multi-Copy. 
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Шаг 8 Указать параметры Number in X/Y (количество копий по осям X и Y), расстояние 

Distance in X/Y (расстояние между копиями). Нажать ОК. Убедиться, что значение 
Distance in X/Y совпадает с указанным в шаге 6. 

 

 
 
 
Примечание. Расстояние по горизонтали и вертикали (Offset X & Y) должно быть ≥ 20 мм 

или = 0 мм. Рекомендуется устанавливать параметр Distance in X/Y на 0 мм, чтобы 
не делать промежутков между копиями для экономии материала. 

 
Шаг 9 Программа создаст насколько копий объекта с приводочными метками, как 

показано на рисунке ниже. 
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Шаг 10 Отпечатать копии изображений, материал с отпечатками загрузить в режущий 
плоттер GCC. 

 

 
 
Шаг 11 В окне GreatCut нажать кнопку Output. 
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Редактирование изображений в Adobe Illustrator 
 
Позиционирование по 4 точкам 

 

Шаг 1 Создать новый файл в Adobe Illustrator. 
 

 
 
Шаг 2 Выбрать изображение и выполнить File > GreatCut > Contour. 
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Смещение контура — 
расстояние между объектом 
и линией контура. 

 
 

Шаг 3 Настроить параметры контура, включая смещение контура, и подтвердить кнопкой 
Calculate (Расчет). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
К объекту добавлена линия контура. 
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Совет: Закругленный контур для векторного объекта 

 

Функция Outline (Контур) повышает качество обработки векторных объектов. На 
острых углах заметна разница между вариантами Normal (Стандарт) и Round 
(Со скруглением). См. рис. ниже: 

 

  
 

Стандарт Со скруглением 

1. Выполнить File > GreatCut > Outline, создав вокруг текстовых объектов 
контуры на свободно задаваемом расстоянии. 

  
 
 

2. Выбрать Round corners и указать параметры Offset и Tolerance. 
Offset — расстояние между внутренним и внешним контуром исходного 
объекта. В поле Tolerance указано, на каком расстоянии от угловой точки 
скругляется срез. 

 
 
 
 
Шаг 4 Выполнить File > GreatCut > Settings. 
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Шаг 5 Нажать кнопку справа от поля Jog marks. 
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Шаг 6 Указать размер, расстояние до объекта и толщину линий приводочных меток и 
подтвердить кнопкой ОК. 

 
 

4-Point Positioning 
 Size Длина меток 
 Диапазон: от 5 до 50 мм 
 Оптимально: 25 мм 

 Object Margin: Расстояние 
между метками и 
изображениями 
 Диапазон: от 0 до 50 мм 
 Оптимально: 5 мм 

 Line thickness: толщина линии 
меток 
 Диапазон: от 1 до 2 мм 
 Оптимально: 1 мм 

 
 
 
 
 
 
 
 
 
Шаг 7 Убедиться, что установлены все три флажка ниже, и нажать ОК. 
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Шаг 8 Выполнить File > GreatCut > Set Jog Marks. 
 

 
 
 
Программа создаст 4 метки, как показано на рисунке ниже. 
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Вывод 
Шаг 1 Выбрать объект целиком, включая приводочные метки и линию контура, 

и выполнить File > GreatCut > Cut. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Шаг 2 Система автоматически активируется и запустит импорт приводочных меток 

и линии контура в GreatCut. 
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Шаг 3 Из меню File выбрать команду Output (Вывод). 
 

 
 
Шаг 4 В окне выбора устройства Output to device в поле Mode/Tool указать Cut with AAS. 
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Шаг 5 Нажать Output — объект будет отправлен на режущий плоттер GCC. 
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Примечание. Разница между параметрами Number of outputs, Number of copies и Step 
count в окне Output. 

 
 

 
 

 
1. Значение параметра Number of outputs — 2: квадрат и треугольник 

вырезаются 1 раз, а затем обе фигуры вырезаются 1 раз в следующей 
позиции. 

 
2. Значение параметра Number of copies — 2: квадрат и треугольник вырезаются 

2 раза в той же позиции. 
 

3. Значение параметра Step count — 2: квадрат вырезается 2 раза в одной 
позиции, треугольник вырезается 2 раза в одной позиции. 
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Расширенная настройка 
 

Позиционирование по сегментам 
Для высокоточной резки рекомендуется выбрать режим Segmental Positioning, повысив 
точность обработки длинных и крупноформатных изображений. 

 
Для настройки линии реза и создания приводочных меток повторить шаги из раздела 
Позиционирование по 4 точкам. В окне настройки указать размер, расстояние от меток 
до объекта, толщину линий приводочных меток, расстояние между метками и 
подтвердить кнопкой ОК. 

 
Шаг 1 Выполнить File > GreatCut > Settings. 
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Шаг 2 Нажать кнопку справа от поля Jog marks. 
 

 
 
 
Шаг 3 Указать размер, расстояние до объекта и толщину линий приводочных меток 

и подтвердить кнопкой ОК. 
 
 
 
 
 
 
 

Позиционирование по 
сегментам 
 Max. x Distance: расстояние 

промежуточного положения 
по оси X 

  Диапазон: 200–500 мм 
 Max. y Distance: расстояние 

промежуточного положения 
по оси X 

  Диапазон: 200–500 мм 
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Шаг 4 Выполнить File > GreatCut > Set Jog Marks. Будут созданы 4 метки, как на рисунке 
ниже. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Ось Y 
 
 
 
 
 
 
 
 
 
 

Ось X 

Позиционирование по 
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Создание копий 
 

Шаг 1 Для настройки линии реза и создания приводочных меток повторить шаги 
из раздела Позиционирование по 4 точкам. 

 
 
 
 
 
 
 
 

При работе с функцией 
Multiple Copies применяются 
параметры, указанные в этом 
разделе. 

 
 
 
 
 
 
 
Шаг 2 Выполнить File > GreatCut > Set Jog Marks. Будут созданы 4 метки, как на рисунке 

ниже. 
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Шаг 3 Выбрать объект целиком, включая приводочные метки и линию контура, 
и выполнить File > GreatCut > Cut.
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Шаг 4 Система автоматически активируется и запустит импорт приводочных меток 
и линии контура в GreatCut. 
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Шаг 5 Из меню File выбрать команду Output (Вывод). 
 

 
 
 
Шаг 6 В поле Mode выбрать Cut with AAS, указать количество изделий по осям X 

и Y, расстояние между копиями. Кнопку Output не нажимать. 
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Шаг 7 Вернуться в Adobe Illustrator. Выполнить File > GreatCut > Multi-Copy. 
 

 
 
 
Шаг 8 Указать параметры Number in X/Y (количество копий по осям X и Y), расстояние 

Distance in X/Y (расстояние между копиями). Нажать ОК. Убедиться, что значение 
Distance in X/Y совпадает с указанным в шаге 6. 

 

 
 
 
Примечание. Расстояние по горизонтали и вертикали (Offset X & Y) должно быть ≥ 20 мм 

или = 0 мм. Рекомендуется устанавливать параметр Distance in X/Y на 0 мм, чтобы 
не делать промежутков между копиями для экономии материала. 
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Шаг 9 Программа создаст насколько копий объекта с приводочными метками, как 
показано на рисунке ниже. 

 

 
 
 
Шаг 10 Отпечатать копии изображений, материал с отпечатками загрузить в режущий 

плоттер GCC. 
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Шаг 11 В окне GreatCut нажать кнопку Output. 
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Программа SignPal 12 совместима с ОС Windows. Все версии поддерживают 
функцию контурной резки AAS II. 

 

Инструкция по SignPal 12: содержание 
[1] Установка программного обеспечения SignPal 12 
[2] Настройка плоттера GCC через Production Manager  
[3] Начало работы с SignPal AASII 
[4] Перечень функций SignPal 12 

 
  [1] Установка программного обеспечения SignPal 12 
Для установки программы необходимы права Администратора (Administrator). Для 
работы с программой необходимы права Опытного пользователя (Power User). 
Подробнее в руководстве пользователя Windows. 

 
1. Удалить предыдущие версии программы, если они есть. 

 
2. Открыть сайт GCC Club (http://gccf.gcc.com.tw/gccclub/login.aspx), войти в систему 

и выполнить Drivers > Cutter > Others > SignPal 12, чтобы загрузить файл WinRAR. 

 
 

3. Установить и активировать SignPal 12, выполнив перечисленные ниже шаги. 

Инструкция по SignPal 12 

http://gccf.gcc.com.tw/gccclub/login.aspx
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(1)Установка и активация ПО на компьютере с интернет-подключением 
 

1. В адресной строке браузера ввести https://www.saicloud.com, нажать Enter. 
Ввести код активации и нажать Activate. Код активации находится на 
этикетке программного обеспечения. 

 
 

 
 

2. При входе в систему выбрать I am new to the SAi Cloud и указать адрес 
электронной почты. Нажать Create Account. На указанный адрес будет 
отправлено сообщение. 

 
 

 

https://www.saicloud.com/
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3. Найти сообщение в почтовом ящике и щелкнуть по ссылке в письме. 

Заполнить поля для информации. 

 
 

 



Expert II. Руководство 

Инструкция по SignPal 12 A-7 

 

 

 
4. С помощью WinRAR запустить из архива файл Autorun. Установить 

программу, следуя подсказкам мастера установки. 
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5. Вставить код в поле для кода активации. 

 

  
 

6. Выбрать нужный язык, нажать OK и завершить установку. 
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(2)Установка и активация ПО на компьютере без интернет-
подключения 

 
1. С помощью WinRAR запустить из архива файл Autorun. Установить 

программу, следуя подсказкам мастера установки. 
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2. Записать идентификационный код компьютера из диалогового окна ниже. 

Найти имя вашего компьютера. Для этого правой кнопкой мыши щелкнуть на 
значке Мой компьютер и выбрать Свойства. 

 

  
 

3. На компьютере с интернет-подключением запустить браузер и набрать 
в адресной строке браузера https://www.saicloud.com. Подтвердить клавишей 
Enter. Ввести код активации и нажать Activate. 
Код активации находится в сертификате программного обеспечения. 

 
 

 

https://www.saicloud.com/
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4. При входе в систему выбрать I am new to the SAi Cloud и указать адрес 

электронной почты. Нажать Create Account. На указанный адрес будет 
отправлено сообщение. 

 

 
 
 

5. Найти сообщение в почтовом ящике и щелкнуть по ссылке в письме. 
Заполнить поля для информации. 
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6. Нажать License Manager can’t connect? (Диспетчер лицензий не может 

подключиться?). Указать код компьютера и имя компьютера, которое вы 
записали ранее. Нажать Create License Now (Создать лицензию) 
и Download License (Загрузить лицензию), сохранить файл на компьютер. 
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7. Скопировать файл лицензии на компьютер без интернет-подключения с диска, 

импортировать его. 
 

 
 

 
 

8. Выбрать нужный язык, нажать OK и завершить установку. 
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(3) Перенос лицензии на компьютере с интернет-подключением 
 

1. Открыть License Manager из меню Start. 
 

 
 

2. Выбрать Remove License From This Computer (Удалить лицензию с этого 
компьютера). Теперь программное обеспечение можно установить на другой 
компьютер. 
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(4)Перенос лицензии на компьютере без интернет-подключения 
1. Открыть License Manager из меню Start. 

 

 
 

2. Выбрать Remove License From This Computer. Ввести код деактивации в 
диалогом окне License. 

 
 

3. На компьютере с интернет-подключением запустить браузер, 
зайти на https://www.saicloud.com и войти в свою учетную запись. Выбрать 
License Removed (Лицензия удалена), ввести код деактивации и нажать 
Remove. Теперь программу можно установить на другой компьютер. 

https://www.saicloud.com/
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 [2] Настройка плоттера GCC через Production Manager 
 

1. Открыть Production Manager 12 
2. Выбрать и настроить режущий плоттер GCC 

(Система AAS II работает только с моделями RX II, Jaguar V LX, Puma III 
Expert II LX.) 
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3. В программе SignPal выполнить File > Print Setup и выбрать принтер. 
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4. В программе SignPal выполнить File > Document Setup и указать формат бумаги. 
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[3] Начало работы с SignPal AASII 
 

1. С помощью инструмента Rectangle создать прямоугольник. 
 

 
 

2. Выполнить Effect > Contour Cut. В окне DesignCentral нажать Apply (Применить). 
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3. Применить метку контурной резки GCC AASII, выполнив Effect > Contour Cut Mark. 
 

 
 
 

4. В окне SignPal DesignCentral выбрать GCC AASII, чтобы создать 
приводочные метки AAS II (позиционирование по 4 точкам). Подтвердить 
кнопкой Apply. 
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5. Есть три варианта приводочных меток GCC AAS II: 4-Point Positioning (по 

4 точкам), Segmental Positioning (по сегментам), Multiple Copies (создание 
копий). Для позиционирования по сегментам в окне DesignCentral выбрать 
GCC Segmentation и нажать Apply. 

 

 
 

6. Создание копий в SignPal недоступно. На текущий момент воспользоваться 
функцией копирования можно только через модуль для CorelDraw. 

 
7. Для вывода изображения выполнить File > Print. 
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8. В окне Print (Печать) установить значение Scale (Масштаб) равным 100 %. 
 

 
 
 

9. Загрузить в плоттер винил и отправить данные командой File > Cut Contour. 
На вкладке Properties (Свойства) диалогового окна Cut Contour доступен 
предварительный просмотр задания. Здесь же можно изменить параметры 
резки. Система Production Manager автоматически активируется для 
выполнения задачи. 
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[4] Перечень функций SignPal 12 
 

 Эксперт Новичок 
Текст 

Работа с текстом ● ● 

Текст по дуге ●  

Текст по кривой ●  

Вертикальный текст ● ● 

По вертикальной кривой ●  

Кернинг ●  

Разделить/Объединить ● ● 

Рисование 

Кривые Безье ● ● 

Свободное рисование ● ● 
 
Фигуры 

Прямоугольник ● ● 

Овал ● ● 

Приводочные метки ● ● 

Размеры ● ● 

Редактировать кривую 

Выбрать точку ● ● 

Удалить точку ●  

Добавить точку ●  

Выпрямить кривую ●  

Скруглить угол ●  

Заострить угол ●  

Оптимизировать по кривой ●  

Оптимизировать по дуге  
 

● 

 

Оптимизировать по 3 точкам дуги ●  

Создать дугу ●  

Сократить число точек ●  

Замкнуть кривую ●  

Изменить начальную точку ●  

Разделить ●  
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Ножницы ●  

Создать прямой угол ●  

Разорвать кривую ●  

Соединить кривые ●  

Выровнять по горизонтали ●  

Выровнять по вертикали ●  

Выровнять точки ●  

Применить длину и 
угол 

 
 

● 

 

Удалить мелкие объекты ●  

Векторный ластик ●  

Разделить по кривой ●  

 
Работа с файлами 
Информация по заданию ●  

Сканирование ●  

Выйти в облако ● ● 

Рабочие области ● ● 

Вид 
DesignCentral ● ● 

Цветовой микшер ● ● 

Захват ● ● 

 
Упорядочивание 
Сгруппировать ● ● 

Объединить ● ● 

Маскировать ● ● 

Направляющие ● ● 

Контурная резка ● ● 

Перевести в кривые ● ● 

Элементы в кривые ● ● 

Преобразовать Linked 

to Native 

 
 

● 

 
 

● 

Направление кривой ● ● 

Упорядочить ● ● 

Порядок резки ● ● 
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Выровнять 

 
 

● 

 
 

● 

Расстояние ● ● 

Повернуть ● ● 

Изменить размер ● ● 

Убрать перекос ● ● 

Зеркально отобразить ● ● 

Многократно копировать ●  

Эффекты 
Комбинирование ●  

Контур ●  

Контурная резка ● ● 

Метка контурной резки ● ● 

Тень ●  

 
Растр 
Автотрассировка ●  

Цветовой режим ●  

Производство 
Резать/рисовать ● ● 

Ручное разделение линий ● ● 

Упорядочить все копии ● ● 

Монтировать до границы ● ● 

Автоматическое слияние ● ● 

Автоматический треппинг ● ● 

Нахлест ● ● 

Оптимизация порядка резки ● ● 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Expert II. Руководство 

Программа Sure Cuts A Lot A-8 

 

 

 

 
 

Ниже приведены базовые сведения по работе с программой Sure Cut A Lot.  
За более подробной информацией обращаться к справочным файлам Sure Cut A Lot. 

 
1. Выбрать нужный принтер и изменить рабочую область. 

 

Шаг 1 Запустить программу Sure Cuts A Lot. 
 

  
 
 

Шаг 2 Для изменения рабочей области в меню Cutter выбрать My Cutter, затем 
Manage Cutters. 

 

 

Программа Sure Cuts A Lot 
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Шаг 3 В списке компаний и марок выбрать GCC и нужную модель, нажать кнопку 
Add to list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Шаг 4 Слева выбрать GCC и нажать Done. 

 

 

Шаг 5 Чтобы изменить размер и ориентацию рабочей области, нужно ввести 
соответствующие значения в окне Document (Документ). 
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2. Вставка изображения из библиотеки 
 

Шаг 1 Для вставки выбрать в библиотеке нужный файл с изображением. 
 

 
 
 
 
3. Добавление текста 

Щелкнув на значке T слева, в текстовом окне ввести текст и выбрать нужный шрифт. 
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Сов
 

 

4. Импортирование макета 
 

Макет из другой графической программы импортируют командой Import или Place 
image из меню File. SCA поддерживает форматы svg, scut, scal, pdf, ai. eps, png и wpc. 

 

 
 

 

Специально для ПО Sure Cuts A Lot созданы тысячи файлов SVG! 
http://SVGCuts.com  — лучший ресурс для создания дизайнов в формате 
SVG. Тысячи элементов в высоком качестве: шаблоны для открыток, 
скрапбукинга, подарочных пакетов, коробок, объемных цветов. 
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5. Преобразование изображения в файл реза 
 

Шаг 1 Открыть окно настройки, выполнив Trace Image (Трассировка изображения) из 
меню File или щелкнув на кнопке Trace Image на панели инструментов. 

 

 
 
 

Шаг 2 Импортировать изображение кнопкой Choose an image, указать настройки 
изображения (Image Settings) и вывода (Output Settings) и нажать OK. 
Программа автоматически создаст контур изображения. 

 
 

 

Примечание 
 На результаты трассировки влияют контрастность и пиксели. 

Предпочтительно импортировать файлы с высокой контрастностью. 
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6. Резка макета 

Шаг 1 Щелчком на кнопке Cutter на панели инструментов открыть диалоговое окно 
настроек. 

 

 
 
Шаг 2 Щелчком на кнопке Settings… открыть диалоговое окно GCC Cutter Settings. 

 

 
 

 
Шаг 3 В окне GCC Cutter Settings при необходимости отрегулировать приводочные метки. 

 

 
 

 

* Registration Marks (Приводочные метки): настроить расстояние между 
кромкой материала и приводочными метками в поле Mark Offset; размер 
меток — в поле Mark Size; толщину линий — в поле Mark Thickness. 

Примечание 
 Исходная точка находится справа внизу. 
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Шаг 4  При необходимости задать настройки Blade Offset, Overcut Value, Multi-Cut 
и Quality в окне CutSettings. 

 

 
 
 

 

* Blade Offset (Смещение ножа): задается с учетом типа ножа; для 
стандартного ножа составляет 0,25 мм, для дополнительного 
улучшенного ножа — 0,5 мм, для дополнительного пера — 0 мм. 

 
* Quality (Качество): чем выше качество, тем ниже скорость 

обработки. 

 
* Multi-Cut (Несколько проходов): для повторного выполнения 

задания из той же позиции при резке толстого материала. 

 
* Overcut (Нахлест): упрощает отделение облоя и компенсирует 

незамкнутые линии реза. 
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Шаг 5 В разделе Cut Settings предусмотрен ряд полезных функций. Задав нужные 
параметры, данные отправляют на режущий плоттер GCC кнопкой Cut. 
Плоттер начинает работу. 

 

 
 
 
 

 

* Cut Mode (Режим резки): параметры WYSIWYG и Origin Point. 
Режим WYSIWYG — плоттер выводит изображение точно так же, 
как в окне предварительного просмотра. В режиме Origin Point 
(Исходная точка) плоттер начинает резку с левой верхней точки 
материала. 

 
* Use Software Speed and Pressure (Программные скорость 

и давление): установите флажок, чтобы вручную задать 
параметры скорости и давления. 

 
* Preset (Предварительные настройки): программа автоматически 

задает скорость и давление реза для выбранного материала. 

 
* Speed & Pressure (Скорость и давление): для повышения 

качества можно настраивать вручную скорость и давление реза. 
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7. Печать и резка макета 
 

Функция Print and Cut позволяет отпечатать изображение из программы Sure Cuts 
A Lot на принтере, а затем загрузить материал с распечаткой в режущий плоттер GCC 
и через Sure Cuts A Lot вырезать по контуру. 

 
Шаг 1 Открыть файл с изображением в программе Sure Cuts A Lot. 

 

 
 
Шаг 2 На панели инструментов нажать на значке плоттера (Cutter), задать нужные 

параметры. Нажать на кнопку Print+Cut, чтобы добавить приводочные метки 
и распечатать изображение. 
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Шаг 3 Нажать кнопку Print… В открывшемся окне настроек принтера выбрать OK. 
 

 
 
 
Шаг 4 Распечатать макет с наружными приводочными метками. 

 

 
 
 
Шаг 5 Загрузить запечатанный материал в режущий плоттер GCC. 

 

Шаг 6 Нажать Next, затем Scan+Cut. Плоттер GCC распознает приводочные метки и 
автоматически вырежет контурные линии. 
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Совет  Как экономить материалы с функцией Test Connection. 
 Нажать кнопку Test Connection, чтобы проверить соединение. 


